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本ガイドについて

改訂： May 30, 2007, OL-8411-04-J

ここでは、『Cisco Service Control Application Reporter ユーザ ガイド』の対象読者、その構成、およ
び表記法について説明します。

このガイドの対象読者は、Cisco Service Control Application Reporter（SCA Reporter）を使用して日常
動作のレポートを生成する、経験を積んだネットワーク管理者です。この概要では、次の各項に関

する情報を提供します。

• マニュアルの変更履歴（p.viii）

• マニュアルの構成（p.ix）

• 表記法（p.x）

• 関連資料（p.xi）

• マニュアルの入手方法、テクニカル サポート、およびセキュリティ ガイドライン（p.xii）
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マニュアルの変更履歴

変更の説明 

• 「Linux 環境での SCA Reporter のインストール」（p.2-9）の追加

• 新しい CLI（コマンドライン インターフェイス）コマンドの追加

• 「レポートのスケジューリング」（p.6-1）の追加

• 「Virtual Links Monitoring テンプレート グループ」（p.D-9）の追加と既存のテンプレート グルー
プへの新しいテンプレートの追加

変更の説明 

編集上の変更のみ

変更の説明 

• オンライン ヘルプの更新

• トラブルシューティング セクションの追加

• 用語集の追加

Cisco Service Control のリリース Part Number 発行日

リリース 3.1.0 OL-8411-04 2007 年 5 月

Cisco Service Control のリリース Part Number 発行日

リリース 3.0.5 OL-8411-03 2006 年 11 月

Cisco Service Control のリリース Part Number 発行日

リリース 3.0.3 OL-8411-02 2006 年 5 月

Cisco Service Control のリリース Part Number 発行日

リリース 3.0.0 OL-8411-01 2005 年 12 月
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マニュアルの構成

このマニュアルの構成は、次のとおりです。

表 1

章 タイトル 説明

第 1 章 一般概要 Cisco Service Control ソリューションの概要、および
システムのコンポーネントについて説明します。

第 2 章 使用する前に Cisco Service Control Application Reporter（SCA
Reporter）の概要について説明します。基本概念、お
よび SCA Reporter のインストール方法と起動方法
について説明します。基本用語についても説明し、

「クイック スタート」セクションもあります。

第 3 章 Cisco SCA Reporter の使用方法 SCA Reporter の基本設定および詳細設定について説
明します。GUI の使用方法についても説明します。

第 4 章 レポート インスタンスの管理 新しいレポート インスタンスの作成や既存のレ
ポート インスタンスの修正など、SCA Reporter の機
能について説明します。

第 5 章 レポートの処理 グラフ表示の方法および調整など、SCA Reporter で
使用できる処理について説明します。

第 6 章 SCA Reporter の CLI SCA Reporter の CLI（コマンドライン インターフェ
イス）を使用してレポートを生成する方法について

説明します。

付録 A SCA Reporter テンプレートのイン
ストールおよびアップグレード

SCA Reporter テンプレートのインストール方法およ
びアップグレード方法について説明します。

付録 B トラブルシューティング SCA Reporter のエラー メッセージ、その考えられる
原因と解決策について説明します。

付録 C SCA BB Console のツールとして
の SCA Reporter

SCA BB Console のツールとしての SCA Reporter に
ついて説明します。

付録 D SCA Reporter テンプレート SCA Reporter テンプレートから作成されたレポート
インスタンスのプロパティについて、テンプレート

グループごとに説明します。
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表記法

このガイドでは、次の表記法を使用しています。

• 太字は、コマンド、キーワード、およびボタンに使用されます。

• イタリック体は、ユーザが値を指定するコマンド入力に使用されます。

• screen フォントは、画面上に表示される情報の例に使用されます。

• 太字の screen フォントは、ユーザが入力する情報の例に使用されます。

• 縦棒（ | ）は、選択要素の区切りを示します。

• 角カッコ（ [ ] ）は、省略可能な要素を示します。

• 波カッコ（ {} ）は、必須の選択肢であることを示します。

• 角カッコ内の波カッコ（ [{}] ）は、省略可能な要素の中の必須選択肢であることを示します。

（注） 「注釈」です。役立つ情報や、このガイド以外の参照資料などを紹介しています。

ワンポイント・アドバイス 「時間の節約に役立つ操作」です。記述されている操作を実行すると時間を節約できます。

注意 「要注意」の意味です。機器の損傷またはデータ損失を予防するための注意事項が記述されていま

す。

警告 「危険」の意味です。人身事故を予防するための注意事項が記述されています。機器の取り扱い作

業を行うときは、電気回路の危険性に注意し、一般的な事故防止対策に留意してください。
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関連資料

ご使用の SCE 2000 プラットフォームとその上で動作するソフトウェアは多彩な特長と機能を備え
ています。詳細については、次のリソースを参照してください。

• Cisco CLI ソフトウェア：

－ 『Cisco Service Control Engine (SCE) Software Configuration Guide』

－ 『Cisco Service Control Engine (SCE) CLI Command Reference』

（注） Web 上にあるシスコのソフトウェア コンフィギュレーションやハードウェアの導入および保守マ
ニュアルは、シスコ Web サイトの URL から入手できます。各国語版のマニュアルは、次の URL か
ら入手できます。http://www.cisco.com/public/countries_languages.shtml

• 初期インストールと起動に関する情報については、『SCE 2000 4xGBE Quick Start Guide』を参照
してください。

• SCE 2000 プラットフォームの WAN（ワイド エリア ネットワーク）インターフェイスに関す
る国際機関の準拠性、安全性、および法律の情報については、『Regulatory Compliance and Safety
Information for Cisco Service Control Engine (SCE)』を参照してください。

• Service Control Management Suite のその他のコンポーネントのインストールと設定については、
次の資料を参照してください。

－ 『Cisco SCMS Subscriber Management User Guide』

－ 『Cisco SCMS Collection Manager User Guide』

－ 『Cisco Service Control Application for Broadband User Guide』

－ 『Cisco Service Control Application Reporter ユーザ ガイド』

• シスコのマニュアルを参照したり、マニュアルに関する一般的情報を入手したりするには、次
のソースを参照してください。

－ マニュアルの入手方法

－ SCE 2000 プラットフォームに付属の『Cisco Information Packet』

http://www.cisco.com/public/countries_languages.shtml
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マニュアルの入手方法、テクニカル サポート、およびセキュリティ ガ
イドライン

マニュアルの入手、テクニカル サポート、マニュアルに関するフィードバックの提供、セキュリ
ティ ガイドライン、および推奨されるエイリアスや一般的なシスコのマニュアルに関する情報につ
いては、毎月更新される『What’s New in Cisco Product Documentation』を参照してください。これに
は、シスコの新規および改訂版の技術マニュアルの一覧も掲載されています。次の URL で入手で
きます。

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Japan TAC Web サイト
Japan TAC Web サイトでは、利用頻度の高い TAC Web サイト（http://www.cisco.com/tac）のドキュ
メントを日本語で提供しています。Japan TAC Web サイトには、次の URL からアクセスしてくだ
さい。

http://www.cisco.com/jp/go/tac

サポート契約を結んでいない方は、「ゲスト」としてご登録いただくだけで、Japan TAC Web サイ
トのドキュメントにアクセスできます。

Japan TAC Web サイトにアクセスするには、Cisco.com のログイン ID とパスワードが必要です。ロ
グイン ID とパスワードを取得していない場合は、次の URL にアクセスして登録手続きを行ってく
ださい。

http://www.cisco.com/jp/register/

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
http://www.cisco.com/tac
http://www.cisco.com/jp/go/tac
http://www.cisco.com/jp/register/
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1
一般概要

この章では、Cisco Service Control ソリューションの概要を示します。Cisco Service Control の概念お
よび機能について説明します。

また、Service Control Engine（SCE）プラットフォームのハードウェア機能、および Cisco Service
Control ソリューションを構成するシスコ固有のアプリケーションについても簡単に説明します。

• Cisco Service Control の概念に関する情報（p.1-2）

• Cisco Service Control の機能（p.1-3）

• SCE プラットフォーム（p.1-4）

• 管理と収集に関する情報（p.1-5）
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Cisco Service Control の概念に関する情報
• Cisco Service Control ソリューション（p.1-2）

• ブロードバンド サービス プロバイダーのサービス コントロール（p.1-2）

Cisco Service Control ソリューション
Cisco Service Control ソリューションは、サービス プロバイダーが直面するさまざまなサービス コ
ントロールの課題を解決する専用ハードウェア、および特定のソフトウェア ソリューションが組み
合わされて実現されます。SCE プラットフォームの設計目的は、インターネット /IP トラフィック
の分類、分析、および制御をサポートすることです。

サービス プロバイダーは Service Control を使用することにより、既存インフラストラクチャに投資
しながら、利益を上げる仕組みを新規に作成することができます。また、マルチギガビット ワイヤ
回線速度で IP ネットワーク トラフィックを分析、課金、および制御することもできます。さらに、
利益率の高いコンテンツベース サービスを識別して目標とし、その実現を可能にするために必要な
ツールも利用できます。

電気通信業界の低迷が示すように、IP サービス プロバイダーのビジネス モデルが利益を上げるた
めには、モデルの再編が必要となります。プロバイダーは巨大なデータ リンクを構築するために莫
大な資金を投入してきたため、多額の負債を抱え、コストの上昇に直面しました。それと同時に、

アクセスおよび帯域幅という商品の価格は継続的に下落し、利益は消滅しました。現在、サービス

プロバイダーは、付加価値のあるサービスを提供して、ネットワーク上で稼働するトラフィックや

サービスからより多くの収入を得る必要があることを認識しています。ただし、IP サービスから実
際に利益を得るには、データ リンク上でこれらのサービスを単に実行するだけでなく、サービス提
供時のサービスの詳細なモニタリングおよび正確でリアルタイムな制御と認識が必要となります。

シスコが提供する Service Control ソリューションを使用すると、サービス プロバイダーはこの
ギャップを埋めることができます。

ブロードバンド サービス プロバイダーのサービス コントロール
住宅およびビジネスのカスタマーをターゲットとするアクセス テクノロジ（DSL、ケーブル、モバ
イルなど）サービス プロバイダーは、拡張 IP サービスによってサービスを差別化しながら、既存
インフラストラクチャから最大限の収益を上げる新しい方法を見つける必要があります。

Cisco Service Control Application for Broadband を使用すると、既存ネットワークに新たなレベルの
サービス インテリジェンスおよび制御機能が追加され、以下のことが可能になります。

• 容量計画のための、サブスクライバ レベルおよび集約レベルでのネットワーク トラフィック
のレポートおよび分析

• カスタマーが直感的に操作できる階層型アプリケーション サービスおよび保証アプリケー
ション SLA の提供

• 各タイプのカスタマー、コンテンツ、またはアプリケーション向けのさまざまなサービス レベ
ルの実装

• Acceptable Use Policy（AUP）に違反しているネットワーク悪用者の識別

• ピアツーピア、NNTP（ニュース）トラフィック、およびスパム悪用者の識別および管理

• AUP の実施

• 既存のネットワーク要素および BSS/OSS システムと Service Control ソリューションとの統合の
簡素化
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Cisco Service Control の機能
Cisco Service Control プラットフォームの中心は、専用ネットワーク ハードウェア デバイスである
SCE です。幅広いアプリケーションをサポートして Service Control ソリューションを実現する SCE
プラットフォームの中心機能は次のとおりです。

• サブスクライバ認識およびアプリケーション認識 ― アプリケーションレベルで IP トラフィッ
クを調査することにより、サブスクライバ単位で使用率およびコンテンツを詳細かつリアルタ

イムに認識および制御することができます。

－ サブスクライバ認識 ― IP フローと特定のサブスクライバを対応付けて、SCE プラット
フォーム経由でトラフィックを送信している各サブスクライバの状態を保守したり、この

サブスクライバ トラフィックに適切なポリシーを適用したりすることができます。

サブスクライバ認識は、DHCP や Radius サーバなどのサブスクライバ管理リポジトリとの専用
統合、または Radius や DHCP トラフィックの調査によって達成されます。

－ アプリケーション認識 ― アプリケーション プロトコル レイヤ（レイヤ 7）までのトラ
フィックを認識および分析できます。

バンドルされたフローを使用して実装されたアプリケーション プロトコル（制御およびデータ
フローを使用して実装された FTP など）の場合、SCE プラットフォームはフロー間のバンドリ
ング接続を認識して、適切に処理します。

• アプリケーション層ステートフル リアルタイム トラフィック制御 ― アプリケーション層ス
テートフル リアルタイム トラフィック トランザクション処理を使用し、詳細な帯域幅測定お
よびシェーピング、クォータ管理、リダイレクションなどの詳細制御機能を実行できます。そ

のためには、適応性の高いプロトコルおよびアプリケーション レベル インテリジェンスが必
要です。

• プログラマビリティ ― 新規プロトコルを迅速に追加して、常に変化するサービス プロバイ
ダー環境に新規サービスおよびアプリケーションを容易に適応させることができます。プログ

ラマビリティは、Cisco Service Modeling Language（SML）を使用して達成されます。

プログラマビリティにより、新規サービスを迅速に配置し、ネットワーク、アプリケーション、

またはサービスの拡張に合わせて容易にアップグレードできます。

• 強力で柔軟なバックオフィス統合 ― プロビジョニング システム、サブスクライバ リポジトリ、
課金システム、OSS システムなど、サービス プロバイダーの既存サードパーティ製システムと
統合できます。SCE には公開され、マニュアルが整備されている一連の API が用意されていて、
迅速かつ強固な統合プロセスを実行できます。

• スケーラブルな高パフォーマンス サービス エンジン ― このすべての操作をワイヤスピードで
実行できます。
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SCE プラットフォーム
プログラム可能なネットワーク デバイスである SCE ファミリーには、IP トラフィックのアプリ
ケーション層ステートフル フロー インスペクションを実行したり、設定可能な規則に基づいてト
ラフィックを制御する機能があります。SCE プラットフォームは ASIC（特定用途向け IC）コン
ポーネントおよび RISC（縮小命令セット コンピュータ）プロセッサを利用する専用ネットワーク
デバイスです。これにより、パケットをカウントするだけでなく、ネットワーク トラフィックの内
容を詳細に調べることができます。双方向トラフィック フローにプログラム可能なステートフル
インスペクションを実行したり、これらのフローとユーザ所有権を対応付けることにより、SCE プ
ラットフォームはネットワーク使用率をリアルタイムで分類できます。この情報は SCE プラット
フォームの高度なトラフィック制御および帯域幅シェーピング機能の基礎となります。一般的な帯

域幅シェーパ機能が適用されない条件下でも、SCE プラットフォームは次のような制御および
シェーピング オプションを提供します。

• レイヤ 7 のステートフル ワイヤ速度パケット インスペクションおよび分類

• 次のような 600 を超えるプロトコルおよびアプリケーションの確実なサポート

－ 一般 ― HTTP、HTTPS、FTP、TELNET、NNTP、SMTP、POP3、IMAP、WAP など

－ P2P ファイル共有 ― FastTrack-KazaA、Gnutella、BitTorrent、Winny、Hotline、eDonkey、
DirectConnect、Piolet など

－ P2P VoIP ― Skype、Skinny、DingoTel など

－ ストリーミングおよびマルチメディア ― RTSP、SIP、HTTP ストリーミング、RTP/RTCP
など

• プログラム可能なシステム コアによる、レポートおよび帯域幅の柔軟な制御

• トランスペアレントなネットワークおよび BSS/OSS と既存ネットワークの統合

• サブスクライバ認識による、トラフィックおよび使用率と特定のカスタマーとの関連付け

次の図は、ネットワークにおける SCE プラットフォームの一般的な展開を示しています。

図 1-1
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管理と収集に関する情報

Cisco Service Control ソリューションには、このソリューションのあらゆる面を管理する、次の管理
コンポーネントを備えた完全な管理インフラストラクチャが含まれています。

• ネットワーク管理

• サブスクライバ管理

• Service Control 管理

これらの管理インターフェイスの設計目的は、一般的な管理基準に準拠して、既存 OSS インフラス
トラクチャとの統合を容易にすることです。

図 1-2

• ネットワーク管理（p.1-5）

• サブスクライバの管理（p.1-6）

• サービス コンフィギュレーションの管理（p.1-6）

• データ収集（p.1-6）

ネットワーク管理

シスコは、完全なネットワーク FCAPS（障害、設定、アカウンティング、パフォーマンス、セキュ
リティ）管理を提供します。

ネットワーク管理用のインターフェイスが 2 つ用意されています。

• CLI（コマンドライン インターフェイス） ― コンソール ポートまたは Telnet 接続でアクセスで
きます。CLI は設定機能およびセキュリティ機能に使用します。

• SNMP ― SNMP トラップによる障害管理機能およびパフォーマンス監視機能が提供されます。
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サブスクライバの管理

Cisco Service Control Application for Broadband（SCA BB）はさまざまなサブスクライバに別々のポ
リシーを提供し、サブスクライバごとに使用量を追跡しますが、Cisco Service Control Management
Suite（SCMS）Subscriber Manager（SM）は、OSS プラットフォームおよび SCE プラットフォーム
の間を橋渡しするミドルウェア ソフトウェアとして使用できます。サブスクライバ情報は SM デー
タベースに格納され、実際のサブスクライバ配置に従って、複数のプラットフォーム間で配信でき

ます。

SM は、ネットワーク ID とサブスクライバ ID のマッピングにより、サブスクライバの認識機能を
実現します。SM は RADIUS や DHCP サーバなどの AAA（認証、許可、アカウンティング）デバ
イスと統合された専用統合モジュールを使用して、サブスクライバ情報を取得できます。

サブスクライバ情報は、次の 2 つの方法のいずれかで取得できます。

• プッシュ モード ― サブスクライバがログオンすると、SM はサブスクライバ情報を SCE プラッ
トフォームに自動的にプッシュします。

• プル モード ― SM は、SCE プラットフォームからのクエリーに応答して、サブスクライバ情
報を SCE プラットフォームに送信します。

サービス コンフィギュレーションの管理
サービス コンフィギュレーション管理は、サービス コントロール アプリケーションの一般的な
サービス定義を設定する機能です。トラフィック分類、アカウンティングとレポート、コントロー

ルの設定を含むサービス コンフィギュレーション ファイルを作成し、SCE プラットフォームに適
用します。SCA BB アプリケーションには、SCE プラットフォームへのコンフィギュレーション
ファイルの配信を自動化するツールがあります。この単純で標準ベースの手法により、巨大ネット

ワークで複数のデバイスを簡単に管理できます。

Service Control にはこれらのファイルを編集および作成するための使いやすい GUI、およびファイ
ルの作成を自動化するための一連の API が備わっています。

データ収集

Cisco Service Control ソリューションは SCE プラットフォームから使用量データおよび統計情報を
生成し、単純な TCP ベース プロトコル（Raw Data Record [RDR] プロトコル）を使用して RDR と
して転送します。SCMS CM ソフトウェアは収集システムを実装し、1 つ以上の SCE プラットフォー
ムからの RDR を待ち受けてローカル マシンで処理します。データは格納されて分析およびレポー
ト機能に使用されたり、収集されて課金など別の OSS システムに提供されます。
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2
使用する前に

Cisco Service Control Application Reporter（SCA Reporter）は、Service Control Engine（SCE）プラッ
トフォームが実行するトラフィック分析に基づいてレポートを生成できる Cisco Service Control
Application ツールです。情報は、SCE プラットフォームから送信されてデータベースに保存されま
す。SCA Reporter は、データベースの情報のクエリーおよび取得を行い、グローバル監視レポート、
サブスクライバ監視レポート、P2P レポート、トラフィック検出統計レポートなどの包括的なレ
ポートという形式で結果を表示します。

• システム コンポーネント（p.2-2）

• システム要件（p.2-3）

• Windows 環境での SCA Reporter のインストール（p.2-4）

• Linux 環境での SCA Reporter のインストール（p.2-9）

• SCA Reporter の起動（p.2-10）

• SCA Reporter の設定（p.2-12）

• オンライン ヘルプの利用方法（p.2-20）

• クイック スタート（p.2-22）
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システム コンポーネント
SCA Reporter は、ネットワークを使用するアプリケーションおよびサブスクライバの動作やリソー
ス消費を把握する場合に役立ちます。また、各規則の有効性や、ネットワークに実装した場合の効

果を判別する場合にも役立ちます。

SCA Reporter は、データベースとともに展開するという形式のみで使用できます。次の方式を使用
してレポートを生成できます。

• スタンドアロン アプリケーション

• CLI（コマンドライン インターフェイス）― 「SCA Reporter の CLI」（p.6-1）を参照してください。

• SCA BB Console ツール ― 「SCA BB Console のツールとしての SCA Reporter」（p.C-1）を参照
してください。

使用可能レポートは、積み重ね棒グラフや面グラフなどのさまざまなグラフ描画や表形式で表示で

きます。3 次元などのさまざまな表示オプションでグラフ表示を調整できます。表レポートおよび
グラフ レポートの両方をファイルにエクスポートできます。プロパティに割り当てる値（時間境界
など）を変更し、レポートを修正することもできます。レポートの複製、エクスポート、保存がで

きます。

GUI を使用せずに SCA Reporter CLI を使用してレポートを生成することもできます。

SCA Reporter は、ビューというビジュアル コンポーネントから構成されます。ビュー、およびそれ
ぞれのビューで実行できるタスクは次のとおりです。

• テンプレート ビュー ― レポート テンプレートの選択、新しいレポート インスタンスの作成、
およびレポートの生成を行います。

• プロパティ ビュー ― フォーカスしたオブジェクトのプロパティとその値を表示します。
フォーカスされるオブジェクトは、テンプレート グループ、レポート テンプレート、レポー
ト インスタンス、レポートのグラフ表示などです。レポート インスタンス プロパティおよび
グラフ表示プロパティの設定もできます。

• レポート ビュー ― レポートのデータをグラフや表形式で表示します。各レポートは、専用の
レポート ビューで表示されます。

• 経過表示ビュー ― 実行またはエクスポートを行ったレポートを監視します。このビューでは
経過詳細を表示でき、バックグラウンドでレポートを生成してその他のレポートでの作業を続

けることを選択することもできます。

レポートの生成は、主に 5 つのステップで構成されます。

1. テンプレート ビューからレポート インスタンスを作成します。

2. プロパティ ビューでレポート インスタンスのプロパティを設定します。

3. レポート インスタンスを実行します。

4. レポート ビューで表形式またはグラフ形式のレポートを表示します。

5. プロパティ ビューでレポートのグラフ表示を調整します。

複数のレポートを同時に生成し、後でエクスポートできます。レポートの実行中は、経過表示ビュー

を使用してレポートを監視し、バックグラウンドでレポートを生成できます。



第 2章      使用する前に
システム要件

2-3
Cisco Service Control Application Reporter ユーザ ガイド

OL-8411-04-J

システム要件

• SCA Reporter GUI フロント エンドとコマンドライン アプリケーションは、Windows 98、
Windows 2000、Windows NT、Windows XP を実行している任意のコンピュータにインストール
し、実行することができます。

• SCA Reporter の Linux 用コマンドライン アプリケーションは、Red Hat Enterprise Linux 4 を実行
している任意のコンピュータにインストールできます。

• コンピュータには最低 512 MB のメモリが必要ですが、1024 MB のメモリを強く推奨します。

• 最低画面解像度は、1024 × 768 ピクセルです。
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Windows 環境での SCA Reporter のインストール
• SCA Reporter のインストール方法（p.2-4）

• SCA Reporter のアンインストール（p.2-8）

SCA Reporter のインストール方法

手順概要

1. SCA Reporter のインストール ファイル SCA Reporter 3.1.0 Setup.exe を選択してダブルクリック
します。

2. [Next] をクリックします。

3.  [Browse] をクリックし、別のインストール先フォルダを選択します。

4. [Next] をクリックします。

5. [Start Menu Folder] フィールドに別のスタート メニュー フォルダを入力します。

6. [Install] をクリックします。

7. インストールが完了するまで待機します。

8. [Next] をクリックします。

9. [Finish] をクリックします。

手順詳細

ステップ 1 SCA Reporter のインストール ファイル SCA Reporter 3.1.0 Setup.exe を選択してダブルクリックしま
す。

[SCA Reporter 3.1.0 Setup] ウィザードの [Welcome] ビューが表示されます。

図 2-1
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ステップ 2 [Next] をクリックします。

セットアップ ウィザードの [Install Location] 画面が開きます。

図 2-2

ステップ 3  [Browse] をクリックし、別のインストール先フォルダを選択します。

ステップ 4 [Next] をクリックします。

セットアップ ウィザードの [Start Menu Folder] 画面が開きます。

図 2-3
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ステップ 5 [Start Menu Folder] フィールドに別のスタート メニュー フォルダを入力します。

[Next] ボタンがイネーブルになります。

ステップ 6 [Install] をクリックします。

セットアップ ウィザードの [Installing] 画面が開きます。

図 2-4

ステップ 7 インストールが完了するまで待機します。

[Next] ボタンがイネーブルになります。

ステップ 8 [Next] をクリックします。

セットアップ ウィザードの [Installation Complete] 画面が開きます。
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図 2-5

ステップ 9 [Finish] をクリックします。

[SCA Reporter 3.1.0 Setup] ウィザードが閉じます。

SCA Reporter がマシンにインストールされました。
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SCA Reporter のアンインストール

手順概要

1. ［スタート］ > ［すべてのプログラム］ > [Cisco SCA] > [SCA Reporter 3.1.0] > [Uninstall] を選択
します。

2. [Yes] をクリックします。

3. [OK] をクリックします。

手順詳細

ステップ 1 ［スタート］ >［すべてのプログラム］> [Cisco SCA] > [SCA Reporter 3.1.0] > [Uninstall] を選択します。

図 2-6

ステップ 2 [Yes] をクリックします。

図 2-7

ステップ 3 [OK] をクリックします。
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Linux 環境での SCA Reporter のインストール
SCA Reporter は Linux 環境でインストールし、コマンドラインから実行できます（「SCA Reporter の
CLI」[p.6-1]  を参照）。

• Linux 環境での SCA Reporter のインストール方法（p.2-9）

• Linux 環境での SCA Reporter のアンインストール方法（p.2-9）

Linux 環境での SCA Reporter のインストール方法

手順概要

1. SCA BB インストール パッケージ（reporter-cmd-linux.tgz ）を CCO からダウンロードします。

2. tar xpzf reporter-cmd-linux.tgz コマンドを使用して、選択したディレクトリでインストール
パッケージを開きます。

3. インストール ディレクトリから、reporter-cmd-linux.tgz –setup コマンドを実行します。

手順詳細

ステップ 1 SCA BB インストール パッケージ（reporter-cmd-linux.tgz）を CCO からダウンロードします。

ステップ 2 tar xpzf reporter-cmd-linux.tgz コマンドを使用して、選択したディレクトリでインストール パッ
ケージを開きます。

ステップ 3 インストール ディレクトリから、reporter-cmd-linux.tgz –setup コマンドを実行します。

Linux 環境での SCA Reporter のアンインストール方法

手順詳細

ステップ 1 インストール ディレクトリを削除します。
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SCA Reporter の起動
SCA Reporter には［スタート］ メニューからアクセスできます。

手順概要

1. ［スタート］ > ［すべてのプログラム］> [Cisco SCA] > [SCA  Reporter 3.1.0] > [SCA Reporter
3.1.0] を選択します。

2. [Welcome] ビューを閉じます。

手順詳細

ステップ 1 ［スタート］ > ［すべてのプログラム］ > [Cisco SCA] > [SCA  Reporter 3.1.0] > [SCA Reporter 3.1.0]
を選択します。

Cisco Service Control SCA Reporter のスプラッシュ画面が表示されます。

図 2-8

SCA Reporter がロードされたあと、SCA Reporter のメイン ウィンドウが表示され、[Welcome] ビュー
が表示されます。



第 2章      使用する前に
SCA Reporter の起動

2-11
Cisco Service Control Application Reporter ユーザ ガイド

OL-8411-04-J

ステップ 2 [Welcome] ビューを閉じます。

テンプレート ビューが表示されます。

図 2-9
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SCA Reporter の設定
SCA Reporter の基本設定を作成する必要がありますが、これには、データベース タイプの選択、
データベースへの接続、データベースのアクティブ化、サービス コンフィギュレーション データ
が使用される Service Control Engine（SCE）プラットフォームの IP アドレスの設定が含まれます。

バンドル モードでは、Cisco Service Control Management Suite（SCMS）Collection Manager（CM）を
Sybase Adaptive Server Enterprise（Sybase ASE）と併用します。Sybase データ管理プラットフォーム
では、トランザクション中心のエンタープライズ アプリケーションがサポートされます。情報の保
存および取得をオンラインで実行でき、必要に応じて情報をウェアハウスに保存できます（詳細に

ついては、『Cisco Service Control Management Suite Collection Manager User Guide』を参照してくださ
い）。Oracle データベースおよび MySQL データベースと連動するように CM を設定することもでき
ます。

データベースをアクティブにしたら、データベースで SCE プラットフォームの 1 つの IP アドレス
を選択する必要があります。[Preferences] ダイアログボックスのタブで表示されるリポジトリごと
に選択する必要があります。SCA Reporter のテンプレート ビューに表示されるすべてのオプション
（使用可能パッケージ、サービスなど）は、設定済み SCE プラットフォームに現在適用されている
サービス コンフィギュレーションによって決まります。各レポートは、それが設定されている SCE
デバイスに従って生成されます。設定例では、1 つの SCE デバイスがデータベースに接続され、1
つのリポジトリ プリファレンスがあります。

• データベース接続の管理（p.2-12）

• SCE プラットフォームの IP アドレスの設定（p.2-17）

• SCA Reporter の詳細オプションの設定方法（p.2-18）

データベース接続の管理

SCA Reporter を使用するには、SCE プラットフォームから作成されたデータが格納されているデー
タベースへの接続を作成し、アクティブにする必要があります。

多数のデータベースへの接続を追加し、必要に応じてアクティブ データベースを変更することがで
きます。

• データベース接続の追加方法（p.2-12）

• データベース接続のアクティブ化方法（p.2-16）

データベース接続の追加方法

手順概要

1. メイン メニューから [Window] > [Preferences] を選択します。

2. プリファレンス ツリーから [Reporter] > [Databases] を選択します。

3. [Databases] ペインで [Add] をクリックします。

4. [Choose definition mode] ラジオ ボタンのうちいずれかを選択します。

5. [Next] をクリックします。

6. すべてのフィールドに値を入力します。

7. [activate this database] チェック ボックスをオンにします。

8. [Finish] をクリックします。

9. [OK] をクリックします。
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手順詳細

ステップ 1 メイン メニューから [Window] > [Preferences] を選択します。

[Preferences] ダイアログボックスが表示されます。

ステップ 2 プリファレンス ツリーから [Reporter] > [Databases] を選択します。

図 2-10

ステップ 3 [Databases] ペインで [Add] をクリックします。

[Add Database] ウィザードが表示されます。

図 2-11
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ステップ 4 [Choose definition mode] ラジオ ボタンのうちいずれかを選択します。

• [Simple]

• [Advanced]

ステップ 5 [Next] をクリックします。

[Add Database] ウィザードの [Define new database connection] 画面が開きます。実際の画面は、ステッ
プ 4 で選択した定義モードによって決まります。

• 単純な画面は次のようになります。

図 2-12

• 詳細な画面は次のようになります。
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図 2-13

ステップ 6 すべてのフィールドに値を入力します。

ステップ 7 [activate this database] チェック ボックスをオンにします。

ステップ 8 [Finish] をクリックします。

[Add Database] ウィザードが閉じます。

データベースの定義が、[Preferences] ダイアログボックスのリストに追加されます。

図 2-14



第 2章      使用する前に
SCA Reporter の設定

2-16
Cisco Service Control Application Reporter ユーザ ガイド

OL-8411-04-J

ステップ 9 [OK] をクリックします。

[Preferences] ダイアログボックスが閉じます。

データベース接続のアクティブ化方法

手順概要

1. メイン メニューから [Window] > [Preferences] を選択します。

2. プリファレンス ツリーから [Reporter] > [Databases] を選択します。

3. アクティブ化するデータベース接続を選択します。

4. [Activate] をクリックします。

5. [OK] をクリックします。

手順詳細

ステップ 1 メイン メニューから [Window] > [Preferences] を選択します。

[Preferences] ダイアログボックスが表示されます。

ステップ 2 プリファレンス ツリーから [Reporter] > [Databases] を選択します。

定義されているすべてのデータベース接続が表に一覧表示されます。

現在アクティブになっているデータベースがあれば、チェック マークで示されます（ ）。

ステップ 3 アクティブ化するデータベース接続を選択します。

ステップ 4 [Activate] をクリックします。

ステップ 5 [OK] をクリックします。

[Preferences] ダイアログボックスが閉じます。
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SCE プラットフォームの IP アドレスの設定
• SCE プラットフォームの IP アドレスの設定方法（p.2-17）

SCE プラットフォームの IP アドレスの設定方法

手順概要

1. メイン メニューから [Window] > [Preferences] を選択します。

2. プリファレンス ツリーから [Reporter] > [Templates] を選択します。

3. [Templates] ペインで、[IP of SCE for policy data] ドロップダウン リストから、サービス コン
フィギュレーション データがレポートで使用される SCE プラットフォームの IP アドレスを選
択します。この IP アドレスは、SCA Reporter のテンプレート リポジトリに追加されます。

4. [Apply] をクリックします。

5. [OK] をクリックします。

手順詳細

ステップ 1 メイン メニューから [Window] > [Preferences] を選択します。

[Preferences] ダイアログボックスが表示されます。

ステップ 2 プリファレンス ツリーから [Reporter] > [Templates] を選択します。

ステップ 3 [Templates] ペインで、[IP of SCE for policy data] ドロップダウン リストから、サービス コンフィ
ギュレーション データがレポートで使用される SCE プラットフォームの IP アドレスを選択しま
す。この IP アドレスは、SCA Reporter のテンプレート リポジトリに追加されます。

ステップ 4 [Apply] をクリックします。

SCE プラットフォームの IP アドレスがサービス コンフィギュレーション データ用に設定されま
す。

（注） [OK] をクリックしてダイアログボックスを閉じる前に、[Apply] をクリックする必要があります。

ステップ 5 [OK] をクリックします。

[Preferences] ダイアログボックスが閉じます。

（注） [Preferences] ダイアログボックスには、Reporter で利用できるリポジトリ（テンプレート セット）
ごとに 1 つのタブがあります。それぞれのタブで 1 つの SCE プラットフォームを選択してくださ
い。複数のリポジトリがある場合は、テンプレート ビュー内に複数のテンプレート グループ セッ
トがあります。
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SCA Reporter の詳細オプションの設定方法
SCA Reporter では、次の詳細オプションを設定できます。

• デバッグ メッセージをログするかどうか

• データベース接続を待ち受ける時間

• 同時に実行できるレポート インスタンスの最大数

手順概要

1. メイン メニューから [Window] > [Preferences] を選択します。

2. プリファレンス ツリーから [Reporter] > [Configuration] を選択します。

3. デバッグ メッセージをロギングするには、[Send debug messages to log] チェックボックスをオ
ンにします。

4. [Seconds to wait for a database connection] フィールドに新しい値を入力します。

5. [Maximum number of reports that can be executed simultaneously] フィールドに、新しい値を入力し
ます。

6. [OK] をクリックします。

手順詳細

ステップ 1 メイン メニューから [Window] > [Preferences] を選択します。

[Preferences] ダイアログボックスが表示されます。

ステップ 2 プリファレンス ツリーから [Reporter] > [Configuration] を選択します。

図 2-15

ステップ 3 デバッグ メッセージをロギングするには、[Send debug messages to log] チェックボックスをオンに
します。

デバッグ メッセージをログすると、ログ ファイルが急速に拡大することがあります。
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ステップ 4 [Seconds to wait for a database connection] フィールドに新しい値を入力します。

ステップ 5 [Maximum number of reports that can be executed simultaneously] フィールドに、新しい値を入力します。

（注） この数を超える実行レポート インスタンスを選択した場合、それらは実行されますが、一部が待
ち状態になります。

ステップ 6 [OK] をクリックします。

新しい設定値が保存されます。

[Preferences] ダイアログボックスが閉じます。
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オンライン ヘルプの利用方法
このユーザ ガイドの関連部分に SCA Reporter からアクセスできます。

• オンライン ヘルプの利用方法（p.2-20）

• オンライン ヘルプの検索方法（p.2-20）

オンライン ヘルプの利用方法

ステップ 1 [Help] メニューから [Help Contents] を選択します。

オンライン ヘルプが別のウィンドウで開きます。

オンライン ヘルプの検索方法
SCA Reporter 内からオンライン ヘルプを検索することもできます。

ステップ 1 [Help ] メニューから [Search] を選択します。

Reporter ウィンドウで [Help] ビューが開きます。

図 2-16

ステップ 2 単語、語句、複雑な検索式を [Search expression] フィールドに入力します。

[Go] ボタンがクリック可能になります。
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（注） [>>]（拡張）をクリックすると、検索式の作成方法が表示されます。

ステップ 3 Go をクリックします。

検索式を含むヘルプ トピックが [Local Help] の下にリスト表示されます。

ステップ 4 ヘルプ トピックをクリックします。内容が表示されます。

（注） トピックにブックマークを付けて後で参照できます。

ステップ 5 [Help] ビュー下部の適切なリンクをクリックすると、以下に切り替えることができます。

• すべてのトピック

• 関連トピック

• ブックマーク
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クイック スタート
このクイック スタート セクションは、SCA Reporter を初めて使用する場合に役立ちます。SCA
Reporter の設定、レポート インスタンスの作成、レポートの生成、およびレポートの処理を行いま
す。

• 最初のレポートの作成方法（p.2-22）

• 最初のレポートの処理方法（p.2-25）

最初のレポートの作成方法

手順詳細

ステップ 1 SCA Reporter を起動します（［スタート］ > ［すべてのプログラム］ > [Cisco SCA] > [SCA Reporter
3.1.0] > [SCA Reporter 3.1.0] を選択します）。

図 2-17

ステップ 2 データベース接続を追加、設定、およびアクティブ化します（「データベース接続の管理」[p.2-12]
を参照）。

ステップ 3 SCE プラットフォームの IP アドレスを設定します（「SCE プラットフォームの IP アドレスの設定」
[p.2-17] を参照）。

ステップ 4 アクティブなデータベースがあり、システムが正しく設定されていることを確認します（「トラブ
ルシューティング」[p.B-1] を参照）。

ステップ 5 テンプレート ビューで、いずれかのテンプレート グループのノードを展開します。
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図 2-18

ステップ 6 レポート テンプレートを右クリックします。

ポップアップ メニューが表示されます。

図 2-19

ステップ 7 メニューから [New] を選択します。

レポート テンプレートの下にレポート インスタンスが追加されます。
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図 2-20

レポート インスタンスの名前は、レポート テンプレートの名前に「#1」を付加したものになりま
す。レポート インスタンスの名前は変更できます。

SCA Reporter ウィンドウの右下にプロパティ ビューが開き、基本的なレポート インスタンス プロ
パティが表示されます。

図 2-21

ステップ 8 （not set）という値を持つプロパティがある場合は、それに値を割り当てます。

ステップ 9 （実行）をクリックします。レポートが生成されます。

SCA Reporter ウィンドウの右上にレポート インスタンスの名前を持つレポート ビューが開き、レ
ポートのグラフが表示されます。

図 2-22
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ステップ 10 レポートを表示します。

グラフ表示プロパティはプロパティ ビューに表示されます。

図 2-23

最初のレポートの処理方法

手順詳細

ステップ 1 前述の手順に従ってレポートを作成します。

ステップ 2 プロパティ ビューでグラフ表示プロパティを修正することによって、グラフ表示を調整します。
（「レポートの処理」[p.5-1]  を参照）。

ステップ 3 レポート ビューにおいて、ビューの上にあるドロップダウン メニューから [Go To Report] を選択
します。

プロパティ ビューに、レポート インスタンス プロパティが表示されます。

ステップ 4 （詳細プロパティ表示）をクリックすることによって、すべてのレポート インスタンス プロ
パティを表示します。

図 2-24
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ステップ 5 1 つまたは複数のプロパティを修正します（「レポート インスタンスの管理」[p.4-1]  を参照）。

ステップ 6 （実行）をクリックします。レポートが再生成されます。

修正されたレポートがレポート ビューに表示されます。

図 2-25

（ここに示した例では、[Select services to view] プロパティが修正され、[Browsing]、[Generic]、お
よび [P2P] がチェックされています。）
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3
Cisco SCA Reporter の使用方法

この章では、Cisco Service Control Application Reporter（SCA Reporter）GUI のナビゲートや設定を含
む使用方法を説明します。

• Reporter のナビゲート：ビュー（p.3-1）

Reporter のナビゲート：ビュー
テンプレート ビューでは、テンプレート グループ、レポート テンプレート、およびレポート イン
スタンスにナビゲートできます。テンプレート ビューで項目を選択すると、そのプロパティがプロ
パティ ビューに表示されます。

レポートを生成するとレポート ビューが開き、そのレポートのグラフ表示プロパティがプロパティ
ビューに表示されます。レポート インスタンス プロパティを表示するには、テンプレート ビュー
でレポート インスタンスを選択します。必要な場合、ドロップダウン メニュー項目 [Go to report]
を選択することによって、そのレポートを生成したレポート インスタンスを特定できます。

各レポート ビューの名前は、そのビューを生成したレポート インスタンスの名前になります。た
とえば、レポートの名前は「Global Bandwidth per Service #1」などです。レポート インスタンス
の名前は、テンプレート ビューで変更できます。

デフォルトでは、各レポート ビューにはレポートのグラフが表示されます。[Table] タブをクリッ
クすると、未加工のデータを表示できます。

• メニュー項目の表示（p.3-1）

• プロパティの設定（p.3-2）

• プロパティ ビュー（p.3-3）

メニュー項目の表示

GUI には、ビューごとにドロップダウン メニューがあります。これには、そのビューで利用できる
すべての操作が表示されます。一部の一般的に使用する処理はアイコンになっているので、簡単に

利用できます。

GUI には、ビューごとにポップアップ メニューもあります。ビューのタブを右クリックしてオプ
ションを選択し、[SCA Reporter] ウィンドウのレイアウトを調整してください。使用可能な処理は
次のとおりです。

• [Detached] ― ビューを切り離し、[SCA Reporter] ウィンドウに移動します。

• [Move] ― ビューまたはタブ グループを移動します。

• [Size] ― ペインのサイズを変更します。
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プロパティの設定

レポートを生成する前に、レポート インスタンス プロパティの値を修正できます。新しい値は保
存され、次回そのレポートが生成されたときに適用されます。

グラフ表示プロパティの値を修正することもできます。グラフ表示プロパティについては、値はた

だちに適用されます。

プロパティのタイプは次のとおりです。

• 値なし ― デフォルト値のない必須プロパティは （not  set）として表示されます。

• フリー テキスト ― 任意の文字列を入力できます。

• ブール値 ― 値によって True と False を切り替えます。

• 日付 ― アイコンをクリックし、[Choose Date and Time] ダイアログボックスを開きます。

• 単一選択 ― アイコンをクリックし、ドロップダウン メニューを開きます。

• 複数選択 ― アイコンをクリックして、複数の値を選択できるダイアログボックスを

開きます。

[Multiple Choice] ダイアログボックスのアイコンについて、次の表で説明します。

（注） 同時に使用できないプロパティがあります。プロパティ [From the last number of hours] および 
[Starting after date and time] の両方を選択しても、両方とも実装することはできません。

（注） このため、指定時刻に始まる時間枠を定義する場合は、[Starting after date] を選択します。[From
the last number of hours] を選択しても、レポートの時間枠は日時の値に従って決まります。

表 3-1 [Multiple Choice] ダイアログボックスのオプション

アイコン オプション 説明

[Select All] すべての値を選択します。

[Invert Selection] オンにしたチェック ボックスをオフにし
て、オフにしたチェック ボックスをオンに
します。

[Select None] すべてのボックスをオフにします。

[Cancel] 保存せずに [Multiple Choice] ダイアログ
ボックスを終了します。

[OK] 保存して [Multiple Choice] ダイアログボッ
クスを終了します。
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プロパティ ビュー
プロパティ ビューには、ビューで選択したフォーカス項目のプロパティが常に表示されます。次の
うちいずれかのボタンをクリックすると、プロパティの表示方法を制御できます。

•

( カテゴリ表示） ― カテゴリも含めて、または含めずにプロパティを表示します。

•

( 詳細プロパティ表示） ― すべてのプロパティ、または基本的なプロパティのみを表示します。

•

( デフォルト値に戻す） ― 選択したプロパティをデフォルト値にリセットします。

－ プロパティがオプションでない場合は設定解除されます。

－ プロパティが必須であってデフォルト値がある場合は、デフォルト値にリセットされます。

－ プロパティが必須であってデフォルト値がない場合、値は変更されません。

プロパティの値を変更するには、プロパティを選択して値を再設定します（「レポート インスタン
スの管理」[p.4-1] および「レポートの処理」[p.5-1] を参照）。次に、そのレポート インスタンスを
再実行し、新しい設定で新しいレポートを表示します。

次の例では、「Package Bandwidth per Service」レポート テンプレートを使用しています。

• プロパティ ビューのプロパティ表示の変更方法（p.3-3）

プロパティ ビューのプロパティ表示の変更方法 

手順詳細

ステップ 1 テンプレート ビューで、レポート テンプレートを選択し、レポート インスタンスを作成します。

プロパティ ビューに、レポート インスタンスのプロパティが表示されます。

図 3-1

デフォルトでは、プロパティ カテゴリが表示され、詳細プロパティは表示されません。

ステップ 2 （カテゴリ表示）をクリックします。

プロパティ カテゴリの表示がオフに切り替わります。
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図 3-2

ステップ 3 （詳細プロパティ表示）をクリックします。

図 3-3

ステップ 4 （カテゴリ表示）をクリックします。

プロパティ カテゴリの表示がオンに切り替わります。

図 3-4
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4
レポート インスタンスの管理

Cisco Service Control Application Reporter（SCA Reporter）のインストールには、次のようなさまざま
なレポートのレポート テンプレートが含まれています。

• 各時間または各日付における、サービスごとのグローバル、パッケージ単位、またはサブスク
ライバ単位の使用量ボリューム

• 上位のサーバ /クライアント /プロトコル /Web ホスト /電子メール送信者 /ニュース グループ

• 上位の P2P コンシューマ /アップローダ /ダウンローダ /プロトコル

• サービスごとのグローバル、パッケージ、またはサブスクライバ帯域幅

各レポート インスタンスは、レポート テンプレートに基づいています。レポート インスタン
スは、SCA Reporter のテンプレート ビューで作成、選択、複製、および削除できます。レポー
ト インスタンスを選択すると、そのプロパティがプロパティ ビューに表示され、さまざまな
レポート プロパティの値を指定できます。たとえば、サービスごとのグローバル帯域幅を確認
する場合は、テンプレート ビューから新しいレポートを作成できます。プロパティ ビューで
は、必要なサービス、トラフィック方向、時間枠（開始時刻および終了時刻、または前の時間

数）を指定できます。すべてのレポート テンプレートの包括的な説明については、「SCA Reporter
テンプレート」（p.D-1）を参照してください。

レポート インスタンスを定義するための手順は、厳密には、選択したレポート テンプレート
によって異なります。この章の例は、新しいレポート インスタンスの作成および定義手順の一
般的なガイドとしてのみご使用ください。

• 新しいレポート インスタンスの作成方法（p.4-2）

• 既存のレポート インスタンスの修正方法（p.4-3）

• レポート インスタンスのプロパティの設定方法（p.4-4）

• 既存のレポート インスタンスの複製方法（p.4-6）

• 既存のレポート インスタンスの名前の変更方法（p.4-7）

• レポート インスタンスの削除方法（p.4-8）
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新しいレポート インスタンスの作成方法

手順概要

1. テンプレート ビューにおいて、レポート インスタンスを右クリックします（たとえば、[Global
Monitoring] > [Global Hourly Aggregated  Minutes per Service]）。

2. メニューから [New] を選択します。

手順詳細

ステップ 1 テンプレート ビューにおいて、レポート インスタンスを右クリックします（たとえば、[Global
Monitoring] > [Global Hourly Aggregated  Minutes per Service]）。

ポップアップ メニューが表示されます。

図 4-1

ステップ 2 メニューから [New] を選択します。

レポート テンプレートの下にレポート インスタンスが追加されます。

図 4-2
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レポート インスタンスの名前は、Global Hourly Aggregated Minutes per Service  #1 です（このレ
ポート テンプレートからレポート インスタンスをもう 1 つ作成した場合、その名前は Global
Hourly Aggregated Minutes per Service  #2 になります。それ以降も同様の方式で命名されます。レ
ポート インスタンスの名前は変更できます）。

SCA Reporter ウィンドウの右下にプロパティ ビューが開き、基本的なレポート インスタンス プロ
パティが表示されます。

図 4-3

（詳細プロパティ表示）をクリックすることによって、すべてのレポート インスタンス プロ
パティを表示できます。

既存のレポート インスタンスの修正方法

手順詳細

ステップ 1 次のうちいずれかを実行します。

• 既存のレポート ビューを選択し、ビューの上にあるドロップダウン メニューから [Go to report]
を選択します。

• テンプレート ビューからレポート インスタンスを選択します。

プロパティ ビューに、レポート インスタンス プロパティが表示されます。

ステップ 2 プロパティの行をクリックし、変更を加えることによって、プロパティを編集します。

変更は保存されます。新しい値は、次回そのレポート インスタンスが実行されたときに使用されま
す。
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レポート インスタンスのプロパティの設定方法
次に、レポート インスタンス プロパティに値を割り当てる例を示します。

ステップ 1 テンプレート ビューでレポート インスタンスを選択します（または作成します）。

レポート インスタンスはテンプレート ビューで選択され、プロパティ ビューにレポート インスタ
ンス プロパティが表示されます。

（注） 修正するプロパティが表示されない場合は、 （詳細プロパティ表示）をクリックします。

ステップ 2 [Traffic Direction] プロパティの行をクリックし、表示される アイコンをクリックします。

次のようなプロパティ値のドロップダウン メニューが表示されます。

図 4-4

ステップ 3 値を選択します。

ステップ 4 [Services to View] プロパティの行をクリックし、表示される アイコンをクリックします。

プロパティ値のチェックリストが表示されます。

図 4-5

ステップ 5 表示するサービスをオンにします。

ステップ 6 （OK）をクリックします。
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ステップ 7 [Ending Before Date] プロパティの行をクリックし、表示される アイコンをクリックします。

[choose date and time] ダイアログボックスが表示されます。

図 4-6

ステップ 8 日時を選択して [OK] をクリックします。

ステップ 9 （実行）をクリックします。

選択した値でレポートが生成されます。
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既存のレポート インスタンスの複製方法
既存のレポート インスタンスに似た新しいレポート インスタンスを作成するには、既存のレポー
ト インスタンスを複製すると便利です。レポート インスタンスを複製し、それを修正した方が、新
しいレポート インスタンスを最初から定義するよりも早く完成できます。

手順概要

1. テンプレート ビューでレポート インスタンスを右クリックします。

2. メニューから [Duplicate] を選択します。

手順詳細

ステップ 1 テンプレート ビューでレポート インスタンスを右クリックします。

ポップアップ メニューが表示されます。

図 4-7

ステップ 2 メニューから [Duplicate] を選択します。

レポート インスタンスが複製されます。
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既存のレポート インスタンスの名前の変更方法
既存のレポート インスタンスの名前を変更できます。同一レポートを定期的に生成する場合は、名
前を変更すると便利です。日付またはその他の識別情報をレポート名に含めることができます。

手順概要

1. テンプレート ビューでレポート インスタンスを右クリックします。

2. メニューから [Rename] を選択します。

3. 新しい名前を入力し、Enterを押します。

手順詳細

ステップ 1 テンプレート ビューでレポート インスタンスを右クリックします。

ポップアップ メニューが表示されます。

図 4-8

ステップ 2 メニューから [Rename] を選択します。

レポート インスタンスが強調表示され、名前を変更できるようになります。

ステップ 3 新しい名前を入力し、Enterを押します。

レポート インスタンスが名前変更され、新しい名前で表示されます。
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レポート インスタンスの削除方法

手順詳細

ステップ 1 テンプレート ビューにおいて、レポート インスタンスを右クリックします（または、レポート イ
ンスタンス選択時に Ctrl キーを押しながら右クリックすることによって複数のインスタンスを選
択します）。

ポップアップ メニューが表示されます。

図 4-9

ステップ 2 メニューから [Delete] を選択します。

選択したレポート インスタンスが削除されます。
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5
レポートの処理

レポート インスタンスを作成および定義したら、そのレポート インスタンスからレポートを生成
できます。

• レポートをグラフまたは表形式で表示します。

• グラフ表示を調整します。

• グラフ表示とレポート データをエクスポートします。

• レポート処理に関する情報（p.5-2）

• レポートの生成方法（p.5-5）

• レポートの表示（p.5-8）

• グラフ表示の調整（p.5-9）

• レポートのエクスポート方法（p.5-18）
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レポート処理に関する情報

SCA Reporter のビューにはメニュー項目が表示されます。一部の一般的に使用する処理はアイコン
になっているので、簡単に利用できます。

処理およびそのアイコンについて、次の表で説明します。

処理 アイコン 説明 説明

[Home] [Welcome] ビューが開きま
す。

[Menu] ビューで使用できるすべて

の処理が表示されます。

すべてのビューに表示されま

す。

[View Filter] — テンプレート ビューでテン
プレート グループの表示を
フィルタリングします。

すべてのテンプレート グルー
プが表示されるか、またはデー

タを生成したサービス コン
フィギュレーションが非対称

ルーティング分類モードで動

作しているときに使用できる

グループのみが表示されます。

[Debug] テンプレート コードを表示
します。

テンプレート ビュー ― レ
ポート テンプレートの構造を
デバッグするために使用しま

す。

[Execute] 選択したレポートを生成し

ます。

プロパティ ビューとテンプ
レート ビューで使用します。

[New or Report (From 
Legend)]

新しいレポート インスタン
スを作成します。

「テンプレート ビュー ― レ
ポート テンプレートを選択す
ると、アイコンは新規になりま

す。」

「各レポート ビュー ― 凡例項
目を右クリックすると、[Subset
of Template Groups and 
Templates] ダイアログボック
スが表示されます。テンプレー

トを選択して [OK] をクリック
します。レポート インスタン
スが作成されます（修正されま

す）。」

[Refresh] テンプレート ビュー内の開
かれたノードが折りたたま

れ、テンプレート グループ
だけが表示された状態にな

ります。

テンプレート ビューで使用し
ます。
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[Show Cmd] ウィンドウが開き、レポー

ト インスタンスの CLI コマ
ンドが表示されます。

「テンプレート ビュー ― CLI
コマンドがクリップボードに

配置されます。バニラ テキス
ト エディタに貼り付けて編集
してから、コマンド ファイル
シェルまたはコマンド プロン
プトから実行できます。」

[Delete] レポート インスタンスを削
除します。

テンプレート ビューで使用し
ます。

[Duplicate] レポート インスタンスのコ
ピーを作成します。

テンプレート ビューで使用し
ます。

[Rename] レポート インスタンスが強
調表示され、名前を変更で

きるようになります。

テンプレート ビューで使用し
ます。

[Show Categories] カテゴリ付きのプロパティ

表示とカテゴリなしのプロ

パティ表示を切り替えま

す。

プロパティ ビューで使用しま
す。

[Show Advanced 
Properties]

基本的なプロパティのみの

表示とすべてのプロパティ

の表示を切り替えます。

プロパティ ビューで使用しま
す。

[Restore Default Value] プロパティのデフォルト値

を復元します。

プロパティ ビュー ― デフォ
ルト値は、特定の値または（not
set）です。必須プロパティは、
（not set）にはリセットされま
せん。

[Go to report] — テンプレート ビューで、選
択したレポート ビューか
ら、関連付けられたレポー

ト インスタンスにナビゲー
トします。

各レポート ビューで使用しま
す。

[Export raw data] — 参照ダイアログボックスを

開きます。

各レポート ビューで使用しま
す。

[Show List] レポート ビューが開かれて
いない生成済みレポートを

一覧表示します。

「レポート ビュー上 ― レポー
トを表示するには、アイコンを

クリックし、ドロップダウン

リストからレポート名を選択

します。」

アイコンの数値は、表示されて

いないレポート数を示します。

処理 アイコン 説明 説明
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[Preferences] — システム タスクを表示する
かどうかを選択できるダイ

アログボックスを開きま

す。

スリープ中（待機中）タス

クはどちらの場合でも表示

されます。

経過表示ビュー ― 

アイコンがシステム タスクの
実行中に表示されます。

[Remove All Finished 
Tasks]

完了したすべてのタスクを

削除します。

経過表示ビューで使用します。

処理 アイコン 説明 説明
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レポートの生成方法

レポートは、既存の定義済みレポート インスタンスから生成できます。レポート インスタンスは
テンプレート ビューに表示されます。レポート インスタンスは複製、修正、名前変更、または削
除できます（「レポート インスタンスの管理」[p.4-1] を参照）。複数のレポートを生成できます。他
のレポートで作業している間、生成プロセスをバックグランドで実行できます。

レポートの中には、非対称ルーティング分類モードで動作する SCE プラットフォームから収集され
たデータを使用して作成することができないタイプもあります。

レポートの定義と生成には、SCA Reporter の CLI（コマンドライン インターフェイス）を使用でき
ます。CLI を使用して、レポートを事前にスケジューリングすることもできます（「SCA Reporter の
CLI」[p.6-1]  を参照）。

• 非対称ルーティング分類モードで生成できるレポート タイプの表示：（p.5-5）

• レポート インスタンスを選択してレポートを生成する方法：（p.5-5）

• 複数のレポートの生成方法（p.5-6）

非対称ルーティング分類モードで生成できるレポート タイプの表示： 

ステップ 1 テンプレート ビューで、ドロップダウン メニューから [View Filter] > [split-flow] を選択します。

レポート インスタンスが非対称ルーティング分類モードのデータについて実行できないテンプ
レート グループは表示されません。

図 5-1

レポート インスタンスを選択してレポートを生成する方法：

ステップ 1 テンプレート ビューでレポート インスタンスを選択します。

プロパティ ビューに、レポート インスタンス プロパティが表示されます。

ステップ 2 （実行）をクリックします。

レポートが生成され、新しいレポート ビューで表示されます。
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プロパティ ビューに、グラフ表示プロパティが表示されます。

複数のレポートの生成方法

ステップ 1 Ctrl キーを押した状態で、テンプレート ビューから複数のレポート インスタンスを選択します。

選択したレポート インスタンスが強調表示されます。

ステップ 2 （実行）をクリックします。

レポートの生成中に経過表示ダイアログボックスが表示されます。

ステップ 3 次のうちいずれかを実行します。

• SCA Reporter の右下にあるシステム タスク ステータスがレポート生成の完了を示すまで待機
します。

レポートの生成中は、システム タスク ステータスが次のようになります。

図 5-2

• [Details] をクリックします。

生成中のすべてのレポートのステータスが表示されます。
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図 5-3

• [Run in Background] をクリックします。

レポート生成がバックグラウンドで実行されます。完了すると、各レポートが別々のレポート

ビューに表示されます。

（注） 経過表示ビューで [Cancel] をクリックすると、レポート生成の実行をキャンセルできます。データ
ベース サーバがキャンセル要求を認識するまでに多少時間がかかることがありますが、キャンセ
ルしたレポートをバックグラウンドに移動して、中断せずに作業を続けることができます。
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レポートの表示

レポートは、グラフまたは表として表示できます。

ステップ 1 必要な表示を選択するには、レポート ビューの左下にある該当するタブをクリックします。

図 5-4

表は、特定の情報を検索する場合に便利です。

図 5-5
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グラフ表示の調整

3 次元表示設定およびグラフのレンダリングなどのグラフ表示プロパティを修正することによっ
て、任意のレポートのグラフの外観およびタイプを変更できます。次の方法でレポートの外観を変

更することもできます。

• レポートの別の場所に凡例をドラッグします。

• 凡例を非表示にします。

• 凡例から項目を隠します。グラフで対応する項目が非表示になります。

• ズーム インまたはズーム アウト ― グラフをドラッグし、目的のセクションに焦点を当てます。

グラフ表示のプロパティの設定

グラフ表示プロパティは、プロパティ ビューで設定します。変更を加えるにしたがって、グラフ表
示は更新されます。レポート ビューで直接行われる調整もあります（「グラフ表示の調整」[p.5-9]
を参照）。

（注） グラフ表示プロパティの変更は、レポート インスタンスには保存されません。レポート インスタ
ンスを次回実行したときには、レポートはデフォルトのグラフ表示プロパティで生成されます。

次の表は、グラフ表示プロパティとその説明の一覧です。

表 5-1 グラフ表示プロパティ

プロパティ タイプ デフォルト 値 説明

[Look] 

3D ブール値 True True、False 2 つの値の間で切り替わ
ります。

Chart rendering 単一選択 レポート テンプ
レートによる

この表の次のリ

ストを参照

多くのグラフィック形式

でグラフを表示できます。

Legend visibility ブール値 True True、False 2 つの値の間で切り替わ
ります。

[Look/3D] 

Oblique ブール値 True True、False 3D が True  のときに限っ
て表示されます。

True の場合は、グラフを
回転したときに X 軸と Y
軸が常に 90 度になりま
す。

Settings スライディン

グ スケール
この表のあとに

掲載されている

表を参照

この表のあとに

掲載されている

表を参照

3D が True  のときに限っ
て表示されます。

8 つのグラフィカル プロ
パティのスライディング

スケールを備えた [3D
properties] ダイアログボッ
クスが開きます。
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Chart Rendering  プロパティに指定できる値は次のとおりです。

グラフの外見の変更

レポートのグラフ タイプの変更、およびグラフのグラフィカル表示の調整を行うことができます。

• グラフ タイプの変更方法（p.5-10）

• グラフィカル表示の修正方法（p.5-11）

グラフ タイプの変更方法

手順概要

1. レポートを生成します。

2. プロパティ ビューで Chart Rendering の行を選択し、[Browse] ボタンをクリックしてドロップ
ダウン リストを開きます。

3. 表示するグラフのタイプをドロップダウン リストから選択します。

手順詳細

ステップ 1 レポートを生成します。

レポート ビューが開き、レポートが表示されます。プロパティ ビューにはグラフ表示プロパティ
が表示されます。

ステップ 2 プロパティ ビューで Chart Rendering の行を選択し、[Browse] ボタンをクリックしてドロップダウ
ン リストを開きます。

• BAR

• STACKED_BAR

• STACKED100_BAR

• SUPERIMPOSED_BAR

• AREA

• STACKED_AREA

• STACKED100_AREA

• POLYLINE

• STACKED_POLYLINE

• STACKED100_POLYLINE

• SCATTER

• STAIR

• STACKED_STAIR

• STACKED100_STAIR

• SUMMED_STAIR

• PIE

表 5-2 [3D properties] ダイアログボックスで設定されるグラフ プロパティ

プロパティ 値 デフォルト

Rotation -90 ... 90 35

Elevation -90 ... 90 45

Depth 0 ... 100 20

Depth Gap 0 ... 100 0

Zoom 0 ... 200 100

Ambient Light 0 ... 100 10

Light Latitude -90... 90 0

Light Longitude -90... 90 0



第 5章      レポートの処理
グラフ表示の調整

5-11
Cisco Service Control Application Reporter ユーザ ガイド

OL-8411-04-J

図 5-6

ステップ 3 表示するグラフのタイプをドロップダウン リストから選択します。

プロパティ ビュー内でどこか別の場所をクリックすると、レポートがアップデートされます。

グラフィカル表示の修正方法

手順概要

1. レポートを生成します。

2. 2 次元でグラフを表示するには、[3D] プロパティをクリックします。

3. [3D] プロパティを再びクリックします。

4. [Settings] プロパティを選択します。

5. スライディング スケールを使用して 3 次元のプロパティを変更します。

6. プロパティの変更に従ってグラフ表示が変化します。

7. [OK] をクリックします。

手順詳細

ステップ 1 レポートを生成します。

レポート ビューが開き、レポートが表示されます。プロパティ ビューにはグラフ表示プロパティ
が表示されます。

ステップ 2 2 次元でグラフを表示するには、[3D] プロパティをクリックします。

[3D] プロパティの値が [True] から [False] に切り替わり、[Look/3D] カテゴリがプロパティ ビュー
から削除されます。

ステップ 3 [3D] プロパティを再びクリックします。

グラフは 3 次元で表示され、[Look/3D ] カテゴリが再び表示されます。

ステップ 4 [Settings] プロパティを選択します。

[3D properties] ダイアログボックスが表示されます。



第 5章      レポートの処理
グラフ表示の調整

5-12
Cisco Service Control Application Reporter ユーザ ガイド

OL-8411-04-J

図 5-7

ステップ 5 スライディング スケールを使用して 3 次元のプロパティを変更します。

ステップ 6 プロパティの変更に従ってグラフ表示が変化します。

ステップ 7 [OK] をクリックします。

新しい値が [Settings] プロパティに割り当てられます。

ズーム

• 2 次元グラフでのズーム イン方法（p.5-12）

• ズーム インされたグラフのドラッグ方法（p.5-13）

• ズーム インされたグラフのズーム アウト方法（p.5-13）

2 次元グラフでのズーム イン方法

2 次元グラフのズーム インまたはズーム アウトを実行できます。

ズーム インしているときは、グラフをドラッグすることで別の部分を表示できます。

手順概要

1. レポートを生成します。

2. 2 次元でグラフを表示するには、[3D] プロパティをクリックします。

3. グラフ上でマウスをドラッグし、長方形を描きます。

4. マウス ボタンから指を離すと、表示がズーム インします。
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手順詳細

ステップ 1 レポートを生成します。

レポート ビューが開き、レポートが表示されます。プロパティ ビューにはグラフ表示プロパティ
が表示されます。

ステップ 2 2 次元でグラフを表示するには、[3D] プロパティをクリックします。

[3D] プロパティの値が [True] から [False] に切り替わり、[Look/3D] カテゴリがプロパティ ビュー
から削除されます。

ステップ 3 グラフ上でマウスをドラッグし、長方形を描きます。

カーソルがプラス アイコンに変化します。

ステップ 4 マウス ボタンから指を離すと、表示がズーム インします。

ズーム インされたグラフのドラッグ方法

手順概要

1. レポートを生成し、2 次元でグラフを表示します。

2. グラフの最上部をズーム インします。

3. グラフを下に移動するには、グラフを右クリックしながらグラフをドラッグします。

手順詳細

ステップ 1 レポートを生成し、2 次元でグラフを表示します。

ステップ 2 グラフの最上部をズーム インします。

ステップ 3 グラフを下に移動するには、グラフを右クリックしながらグラフをドラッグします。

グラフが上に移動し、グラフの下の部分が表示されます。

ズーム インされたグラフのズーム アウト方法

手順概要

1. Shift キーを押した状態で、チャート上でマウスをドラッグし、長方形を描きます。

2. マウス ボタンから指を離すと、表示がズーム アウトします。
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手順詳細

ステップ 1 Shift キーを押した状態で、チャート上でマウスをドラッグし、長方形を描きます。

カーソルがマイナス アイコンに変化します。

ステップ 2 マウス ボタンから指を離すと、表示がズーム アウトします。

変数の非表示化

レポートに含まれる変数を非表示化することで、それらがグラフに表示されないようにできます。

（注） また、レポート インスタンスを修正することによって、レポートに含める変数を選択できます（「レ
ポート インスタンスの管理」[p.4-1]  を参照）。

• グラフ内の変数を非表示化する方法（p.5-14）

• 非表示化された変数を再表示する方法（p.5-16）

グラフ内の変数を非表示化する方法

手順概要

1. レポートを生成します。

2. 凡例内で変数を右クリックします。

3. メニューから [Hide] を選択します。

手順詳細

ステップ 1 レポートを生成します。

レポート ビューが開き、レポートが表示されます。

図 5-8



第 5章      レポートの処理
グラフ表示の調整

5-15
Cisco Service Control Application Reporter ユーザ ガイド

OL-8411-04-J

ステップ 2 凡例内で変数を右クリックします。

ポップアップ メニューが表示されます。

図 5-9

ステップ 3 メニューから [Hide] を選択します。

変数は凡例内で表示が暗くなり、グラフから削除されます。

図 5-10
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非表示化された変数を再表示する方法

手順概要

1. 凡例内で暗く表示された変数を右クリックします。

2. メニューから [Show] を選択します。

手順詳細

ステップ 1 凡例内で暗く表示された変数を右クリックします。

ポップアップ メニューが表示されます。

図 5-11

ステップ 2 メニューから [Show] を選択します。

変数は凡例内で復元され、グラフに表示されます。

図 5-12
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グラフの凡例の管理

グラフの凡例はデフォルトの位置から移動したり、グラフ表示から削除したりできます。

• グラフの凡例を移動する方法（p.5-17）

• グラフの凡例を非表示化する方法（p.5-17）

グラフの凡例を移動する方法

手順詳細

ステップ 1 レポートを生成します。

レポート ビューが開き、レポートが表示されます。

ステップ 2 グラフの凡例を右クリックし、それを必要な位置にドラッグします。

凡例が新しい位置に移動します。

グラフの凡例を非表示化する方法

手順詳細

ステップ 1 レポートを生成します。

プロパティ ビューに、グラフ表示プロパティが表示されます。

ステップ 2 グラフの凡例を非表示化するには、[Legend visibility] プロパティをクリックします。

[Legend visibility] プロパティの値が [True] から [False] に切り替わり、グラフの凡例がグラフから
削除されます。
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レポートのエクスポート方法

レポートは多くのグラフィック形式でエクスポートでき、表は CSV 形式または Quoted CSV 形式で
エクスポートしてスプレッドシートで開くことができます。複数のレポートを 1 回のエクスポート
操作でエクスポートできます。

手順概要

1. 1 つ以上のレポート インスタンスを実行した後で、[File] > [Export] を選択します。

2. [Chart] または [Table] を選択します。

3. [Next] をクリックします。

4. [Available reports] のうち 1 つ以上をオンにします。

5. [Output folder] を変更するには、[Browse] をクリックします。

6. [Next] をクリックします。

7. 次のうちいずれかを実行します。

8. [Finish] をクリックします。

手順詳細

ステップ 1 1 つ以上のレポート インスタンスを実行した後で、[File] > [Export] を選択します。

[Export] ウィザードが表示されます。

図 5-13

ステップ 2 [Chart] または [Table] を選択します。

ステップ 3 [Next] をクリックします。

[Export] ウィザードの [Tables and Destinations] 画面が開きます。
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図 5-14

ステップ 4 [Available reports] のうち 1 つ以上をオンにします。

ステップ 5 [Output folder] を変更するには、[Browse] をクリックします。

ステップ 6 [Next] をクリックします。

[Export] ウィザードの [Format] 画面が開きます（この画面は、ステップ 2 で [Chart] を選択したか
[Table] を選択したかによって決まります）。

ステップ 7 次のうちいずれかを実行します。

• （グラフの場合）[File type] ドロップダウン リストからファイル タイプを選択します。[Image
width] フィールドおよび [Image height] フィールドに、ピクセル単位の値を入力します。
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図 5-15

• （表の場合）[File type] ドロップダウン リストからファイル タイプを選択します。

図 5-16

ステップ 8 [Finish] をクリックします。

選択した各レポートが別々のファイルに保存されます。
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6
SCA Reporter の CLI

この章では、Cisco Service Control Application Reporter（SCA Reporter）の CLI（コマンドライン イン
ターフェイス）を使用して SCA Reporter 機能を実行するさまざまな方法（構文、スイッチ、アプリ
ケーションのオプションなど）について説明します。

• CLI の概要（p.6-1）

• レポートのスケジューリング（p.6-1）

• 構文と使用法（p.6-2）

CLI の概要
SCA Reporter の CLI（コマンドライン インターフェイス）はコマンドライン アプリケーションであ
り、SCA Reporter GUI の機能を補足するものです。CLI は、SCA Reporter の GUI よりも高機能で柔
軟であり、サードパーティ製アプリケーションに統合して使用量ベースの出力および統計ベースの

出力を生成できます。

CLI は、次の機能を備えています。

• Windows または Linux 環境で実行できます。

• 定義済みのレポート インスタンスを実行したり、レポート テンプレートを使用したりできま
す。

• レポートを定期的に生成するようにスケジューリングできます。

レポートのスケジューリング

Reporter CLI を使用すると、選択したレポートを定期的に生成できます。これを行うには、外部の
スケジューリング ユーティリティ（cron、PyCron、Windows スケジューラなど）を設定する必要が
あります。次の項で説明するとおり、既存のレポート インスタンス、またはレポート テンプレー
トを使用できます。

次に示すのは、1 時間ごとに「Global Bandwidth per Service」レポートを生成する cron 行の例です。

20 * * * * reportercmd -report "Global Bandwidth per Service #1" -params \
"numhours=24;units=Mbit/s;avgdata=true;trafficdir=Both Directions" \
-format jpeg -o GBpS1.jpeg
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構文と使用法

SCA Reporter をコマンドライン バージョンとして実行し、入力をパラメータとして渡すことができ
ます。テンプレート ビューでは、レポート インスタンスまたはレポート テンプレートのいずれか
から CLI コマンドを作成できます。データベース情報および SCE プラットフォームの IP パラメー
タは、作成された CLI コマンドに設定済みパラメータとともに組み込まれます。

コマンドを作成すると、そのコマンドは自動的にクリップボードにコピーされるので、コマンド

ファイル シェルまたはコマンド プロンプトに貼り付け、必要な変更を加えてから実行できます。
データを保存するためのファイル名と形式を追加する必要があります。これらのパラメータは、コ

マンド作成時には含まれていません。

元のレポート インスタンスに存在するすべてのパラメータが、params スイッチに組み込まれるわ
けではありません。パラメータが CLI 呼び出しで具体的にリストされていないときは、次のように
なります。

• コマンドがレポート インスタンスに基づいている場合、その値はレポート インスタンスから
取得されます。

• コマンドがレポート テンプレートに基づいている場合は、デフォルト値が使用されます（デ
フォルト値のない必須パラメータの値は定義する必要があります）。

コマンドラインの使用法

SCA Reporter アプリケーションは、次のようなコマンドを使用して呼び出すことができます。

reportercmd -report "Global Bandwidth per Service 
#1"-dbdriver"com.mysql.jdbc.Driver"-dburl "jdbc:mysql://127.0.0.1:3306/apricot" 
-dbuser "pqb_admin"-dbpassword "pqb_admin"-policysce 
"10.1.12.85"-params"numhours=240000000;seip=10.1.12.85;avgdata=true;link=Link 0,Link 
1;traficdir=Both Directions;services=Messaging Service,Generic UDP Service,Generic TCP 
Service,News Service,FTP Service,Browsing Service,Default Service"-o "myfile"-format 
"jpeg"

SCA Reporter から CLI コマンドの基礎となる文字列を生成できます。生成されたコマンドには、-o
パラメータや -format パラメータは含まれていません。これらはコマンドに追加する必要がありま
す。その他のパラメータを修正することもできます。

コマンドライン スイッチ
SCA Reporter アプリケーションを呼び出す際、コマンドラインに次のスイッチを含めることができ
ます。

• -report

－ -dbdriver

－ -dburl

－ -dbuser

－ -dbpassword

－ -policysce

－ -params

－ -o

－ -format

－ -show

• -template

－ -dbdriver

－ -dburl

－ -dbuser
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－ -dbpassword

－ -policysce

－ -params

－ -o

－ -format

－ -show

• -help

• -list

コマンドライン オプション
SCA Reporter アプリケーションを呼び出すコマンド ラインのオプションについて、次の表で説明し
ます。

表 6-1 SCA Reporter アプリケーションのコマンドライン オプション

オプション SCA Reporter による処理 説明

-report" report-name" 指定された名前のレポート イン
スタンスを使用して、レポートを

生成します。

このパラメータは、既存のレ

ポート インスタンスからレ
ポートを生成するときに使

用します。

-template" template-name" 指定された名前のレポート テン
プレートを使用して、レポートを

生成します。

このパラメータは、テンプ

レートからレポートを生成

するときに使用します。

-dbdriver" db-driver" データベースのドライバ SCA Reporter で設定されてい
るものと同じデータベース

-dburl" db-url" データベースの URL 　

-dbuser" db-user" データベースのユーザ 　

-dbpassword" db-password" データベースのパスワード 　

-policysce" IP of SCE for 
policy data"

サービス コンフィギュレーショ
ン データがレポートで使用され
る SCE プラットフォームの IP ア
ドレス

SCA Reporter で設定されてい
る SCE プラットフォームの
IP アドレス

-params" param1=value1;..." プロパティ ビューからのパラ
メータ

特定パラメータを指定しな

い場合は、デフォルト値が使

用されます。

-o" filename" 出力を保存するファイルの名前 そのファイル名がすでに存

在する場合、元のファイルは

上書きされます。

-format" fileformat" レポートをグラフとして出力す

るか、表として出力するかを指定

します。fileformat パラメータ
には、次の値のいずれかを指定で

きます。

• jpeg 

• csv 

　

-show 実行せずに、レポートまたはテン

プレートの構造（パラメータを含

む）を表示します。
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レポート インスタンスでの Reporter コマンドの生成方法

手順概要

1. テンプレート ビューからレポート インスタンスを選択します。

2. タブのドロップダウン メニューから [Show Cmd] を選択します。

3. [OK] をクリックします。

4. 次のうちいずれかを実行します。

5. クリップボードの内容を貼り付けます。

6. 次の必須フラグを追加します。

7. パラメータを変更します。たとえば numhours パラメータを変更できます。

8. コマンドを実行します。

手順詳細

ステップ 1 テンプレート ビューからレポート インスタンスを選択します。

ステップ 2 タブのドロップダウン メニューから [Show Cmd] を選択します。

コマンドライン呼び出しダイアログボックスが表示され、生成されたコマンドが表示されます。

図 6-1

ステップ 3 [OK] をクリックします。

コマンドおよびすべてのスイッチとパラメータがクリップボードに配置されます。

-help 　 　

-list すべてのテンプレート グループ
とレポート テンプレートの一覧
を出力します。

　

表 6-1 SCA Reporter アプリケーションのコマンドライン オプション（続き）

オプション SCA Reporter による処理 説明
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ステップ 4 次のうちいずれかを実行します。

• シェルからコマンドを実行するファイルを開き、Reporter ディレクトリにファイルを保存しま
す。

• CLI コマンドを実行するコマンド プロンプトを開き、ディレクトリを Reporter ディレクトリに
変更します。

ステップ 5 クリップボードの内容を貼り付けます。

ファイルまたはコマンド ラインにコマンドが貼り付けられます。

ステップ 6 次の必須フラグを追加します。

• • -o" filename"

• • -format" fileformat"

ステップ 7 パラメータを変更します。たとえば numhours パラメータを変更できます。

図 6-2

ステップ 8 コマンドを実行します。

エクスポートされたファイルが定義済みディレクトリに保存され、レポート インスタンス名にタイ
ム スタンプが付きます。

レポート テンプレートでの Reporter コマンドの生成方法

手順概要

1. テンプレート ビューからレポート インスタンスを選択します。

2. タブのドロップダウン メニューから [Show Cmd] を選択します。

3. [OK] をクリックします。

4. 以前の手順のステップ 5 以降を実行します。
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手順詳細

ステップ 1 テンプレート ビューからレポート インスタンスを選択します。

ステップ 2 タブのドロップダウン メニューから [Show Cmd] を選択します。

図 6-3

コマンドおよびすべてのスイッチとパラメータがクリップボードに配置されます。

デフォルト値があるパラメータには、デフォルト値が付与されます。デフォルト値のない必須パラ

メータは、___（下線）の値で示されます。

ステップ 3 [OK] をクリックします。

コマンドおよびすべてのスイッチとパラメータがクリップボードに配置されます。

ステップ 4 以前の手順のステップ 5 以降を実行します。
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A
SCA Reporter テンプレートのインス
トールおよびアップグレード

この付録では、Cisco Service Control Application Reporter（SCA Reporter）のレポート テンプレート
のインストール方法およびアップグレード方法について説明します。

• レポート テンプレートのインストール方法（p.A-1）

• レポート テンプレートのアップグレード方法（p.A-8）

レポート テンプレートのインストール方法

手順概要

1. メイン メニューから [Help] > [Find and Install] を選択します。

2. [Search for new feature to install] ラジオ ボタンをオンにして [Next] をクリックします。

3. [New archived site] をクリックします。

4. アーカイブ ファイルを参照して選択します。

5. [Open] をクリックします。

6. [OK] をクリックします。

7. [Finish] をクリックします。

8. 契約内容に同意し、[Next] をクリックします。

9. 必要な機能を選択します。名前は SCAS BB Templates<version.<build> という形式になってい
ます。たとえば、ファイルは SCAS BB Template 3.1.0.8 という名前になっています。

10. さまざまな場所にある機能をインストールするには、[Change Location] をクリックし、必要な
場所を参照します。

11. [Finish] をクリックします。

12. [Install] または [Install All] をクリックします。

13. [Yes] をクリックし、アプリケーションがアップするまで待機します。
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手順詳細

ステップ 1 メイン メニューから [Help] > [Find and Install] を選択します。

図 A-1

ステップ 2 [Search for new feature to install] ラジオ ボタンをオンにして [Next] をクリックします。
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図 A-2

ステップ 3 [New archived site] をクリックします。

[Select Local Site Archive] ダイアログボックスが表示されます。

ステップ 4 アーカイブ ファイルを参照して選択します。

ファイルの名前は、SCAS_bb_template_.<versionB<build>.zip という形式です。たとえば、ファイ
ル名は SCAS_bb_template_3.1.0B8.zip になります。

ステップ 5 [Open] をクリックします。

ZIP ファイル名および内容を含む URL が [Edit Local Site] ダイアログボックスに表示されます。

図 A-3
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ステップ 6 [OK] をクリックします。

図 A-4

ステップ 7 [Finish] をクリックします。
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図 A-5

ステップ 8 契約内容に同意し、[Next] をクリックします。

そのサイトで使用できるインストール済み機能が [Updates] ダイアログボックスに表示されます。

ステップ 9 必要な機能を選択します。名前は SCAS BB Templates<version.<build> という形式になっています。
たとえば、ファイルは SCAS BB Template 3.1.0.8 という名前になっています。
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図 A-6

ステップ 10 さまざまな場所にある機能をインストールするには、[Change Location] をクリックし、必要な場所
を参照します。

ステップ 11 [Finish] をクリックします。
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図 A-7

ステップ 12 [Install] または [Install All] をクリックします。

ステップ 13 [Yes] をクリックし、アプリケーションがアップするまで待機します。

コンピュータが再起動します。

新しいレポート テンプレートがインストールされます。
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レポート テンプレートのアップグレード方法

ステップ 1 メイン メニューから [Help] > [Find and Install] を選択します。

[Install/Update] ダイアログボックスが表示されます。

図 A-8

ステップ 2 [Search for updates of the currently installed  features] ラジオ ボタンをオンにします。

ステップ 3 [Finish] をクリックします。

次のうちいずれかの結果になります。

• アップデートがありません。
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図 A-9

• アップデートがあります。

ウィザードが表示されます（「レポート テンプレートのインストール方法」[p.A-1] を参照）。
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B
トラブルシューティング

Cisco Service Control Application Reporter（SCA Reporter）を使用しているときに問題が発生した場合
は、この付録に含まれる情報を利用して原因を特定してください。この付録の手順では、最初のシ

ステム起動をトラブルシューティングしていること、および GUI が出荷時の設定になっていること
が想定されています。デフォルト設定を変更した場合は、この付録の推奨事項が適用されないこと

があります。

• この付録の使用法（p.B-1）

• 一般事項（p.B-2）

• 一般的なセットアップ エラー（p.B-2）

• コマンドライン インターフェイス（p.B-2）

• パラメータ定義エラー（p.B-3）

• システム状態の確認方法（p.B-4）

• エラー ログの表示方法（p.B-4）

• インストールされているレポート テンプレートのバージョンを確認する方法（p.B-5）

この付録の使用法

この付録では、効率的な問題解決のために利用できるサブシステムについて説明します。この付録

に記載されたソリューションを適用しても問題を解決できない場合は、カスタマー サービス担当者
に支援を要請してください。担当者には、次の情報をお伝えください。

• ソフトウェア タイプおよびリリース番号

• 問題の簡潔な説明

• 問題を突き止めて解決するために実行した手順の簡潔な説明

• 保守契約または保証の情報
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一般事項

[Help] メニューを検索すると、作業中に SCA Reporter について調べることができます。[Help] メ
ニューの次の機能によって役立つ情報を得ることができます。

• 基本設定の作成

• オンライン ヘルプの利用方法

• システム状態の確認

• 設定の管理

• テンプレートのインストールおよびアップグレード

• プラグインの詳細表示

SCA Reporter の操作中にオンライン ヘルプを利用することもできます（「使用する前に」[p.2-1] を
参照）。

一般的なセットアップ エラー
GUI が開かない場合は、以下を確認してください。

• メモリが十分にあること。

• 古いリリースをアンインストールしてから新しいリリースをインストールしたこと。

• データベースがインストールされていてデータが入力されていること。

• コンピュータの IP アドレスが別のデバイスに接続されていないこと。

コマンドライン インターフェイス
SCA Reporter の CLI（コマンドライン インターフェイス）の使用法およびトラブルシューティング
については、『Cisco Service Control Engine (SCE) CLI Command Reference』の次のセクションを参照
してください。

• 「CLI Help Features」

• 「Navigational and Shortcut Features」

• 「Managing Command Output」
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パラメータ定義エラー

次の例では、必須プロパティが設定されていません。

図 B-1

レポート インスタンスを実行すると、エラー メッセージが表示されます。

図 B-2

[Details] をクリックし、エラーの詳細を表示します。

図 B-3
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システム状態の確認方法

以下を確認できます。

• データベース接続が正しく定義されていること、および接続がアクティブであること

• システムが正しく設定されていること

手順詳細

ステップ 1 メイン メニューから  [Help] > [Check Conditions] を選択します。

状態のテスト メッセージが表示されます。

図 B-4

ステップ 2 [OK] をクリックします。

エラー ログの表示方法
デバッグ メッセージ ロギングを設定するには、「使用する前に」（p.2-1）を参照してください。こ
のモードをアクティブにすると、エラー ログを表示できます。

ステップ 1 メイン メニューから [Help] > [About SCA Reporter] を選択します。

[About SCA Reporter] ダイアログボックスが表示されます。

ステップ 2 [Configuration Details] をクリックします。

ステップ 3 [View Error Log] をクリックします。
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インストールされているレポート テンプレートのバージョンを確認す
る方法

データベース構造を変更したが、リポジトリを更新しなかった場合は、テンプレート リポジトリ
エラーが発生することがあります（「SCA Reporter テンプレートのインストールおよびアップグレー
ド」[p.A-1] を参照）。

（注） インストールおよびアップグレードに使用するファイルは、インストール前に更新する必要があり

ます。

ステップ 1 メイン メニューから [Help] > [About SCA Reporter] を選択します。

[About SCA Reporter] ダイアログボックスが表示されます。

ステップ 2 [Plug-in Details] をクリックします。

[About SCA Reporter Plug-ins] ダイアログボックスが表示されます。

ステップ 3 SCA BB テンプレートのバージョンが正しいことを確認します。

ステップ 4 [OK] をクリックします。

[About SCA Reporter Plug-ins] ダイアログボックスが閉じます。

ステップ 5 [OK] をクリックします。

[About SCA Reporter] ダイアログボックスが閉じます。



付録 B      トラブルシューティング
インストールされているレポート テンプレートのバージョンを確認する方法

B-6
Cisco Service Control Application Reporter ユーザ ガイド

OL-8411-04-J



A P P E N D I X

C-1
Cisco Service Control Application Reporter ユーザ ガイド

OL-8411-04-J

C
SCA BB Console のツールとしての 
SCA Reporter

この付録では、SCA BB Console のツールとしての Cisco Service Control Application Reporter（SCA
Reporter）について説明します。SCA BB Console の詳細については、『Cisco Service Control Application
for Broadband User Guide』を参照してください。

• SCA BB Console での SCA Reporter ツールの使用方法（p.C-1）

SCA BB Console での SCA Reporter ツールの使用方法  
SCA Reporter は、SCA BB Console のツールとして実行できます。

手順概要

1. [スタート ] > [すべてのプログラム ] > [Cisco SCA] > [SCA BB  Console 3.1.0] > [SCA BB Console
3.1.0] を選択します。

2. データベース接続を設定し、アクティブ化します（「使用する前に」[p.2-1] を参照）。

3. Console のメイン メニューから [Tools] > [Reporter] を選択します。

4. 本マニュアルの説明に従い、SCA Reporter をスタンドアロンで使用する場合と同様に Reporter
ツールを使用します。

手順詳細

ステップ 1 [スタート ] > [すべてのプログラム ] > [Cisco SCA] > [SCA BB  Console 3.1.0] > [SCA BB Console
3.1.0] を選択します。

SCA BB Console が開きます。
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図 C-1

ステップ 2 データベース接続を設定し、アクティブ化します（「使用する前に」[p.2-1] を参照）。

ステップ 3 Console のメイン メニューから [Tools] > [Reporter] を選択します。

Reporter ツールが開きます。

図 C-2
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ステップ 4 本マニュアルの説明に従い、SCA Reporter をスタンドアロンで使用する場合と同様に Reporter ツー
ルを使用します。

図 C-3
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D
SCA Reporter テンプレート

この付録では、Cisco Service Control Application Reporter（SCA Reporter）のレポート テンプレート
について説明します。

• レポート テンプレートに関する情報（p.D-2）

• Global Monitoring テンプレート グループ（p.D-7）

• Package Monitoring テンプレート グループ（p.D-8）

• Virtual Links Monitoring テンプレート グループ（p.D-9）

• Subscriber Monitoring テンプレート グループ（p.D-10）

• Traffic Discovery - Statistics テンプレート グループ（p.D-11）

• Demographic Data and Service Popularity レポート テンプレート グループ（p.D-12）

• Web and Streaming レポート テンプレート グループ（p.D-13）

• Mail and News レポート テンプレート グループ（p.D-14）

• P2P レポート テンプレート グループ（p.D-14）

• VoIP レポート テンプレート グループ（p.D-15）

• Malicious Traffic テンプレート グループ（p.D-16）
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レポート テンプレートに関する情報
SCA Reporter のインストールには、レポート インスタンスの作成に使用するレポート テンプレー
トが含まれます。これらのテンプレートは、共通のテーマごとにグループ化されています。それぞ

れのレポート テンプレートでは、新しいレポート インスタンスを作成できます。プロパティには
デフォルト フィルタ値が割り当てられ、その一部は特定グループのすべてのインスタンスで共通で
す。プロパティを設定すると、さらに制約をかけることができます。

（注） デフォルト フィルタは、プロパティに最初に適用される値です。レポートを作成する前に、その
プロパティを再設定できます。プロパティをデフォルト値にリセットするには、プロパティを選択

してクリックします。

（注） ( Restore Default   Value）。必須プロパティの中には、デフォルト値 （not set）を持つ
ものがあります。レポートを作成するには、これらのプロパティに値を割り当てる必要がありま

す。オプション プロパティには、not set という値を割り当てることができます。すべてのプロパ
ティを表示するには、 （Show Advanced Properties）をクリックします。

テンプレート ビューの使用可能グループのリストからレポート テンプレートを選択して、レポー
ト インスタンスを生成します。

レポートには、次の 2 つのメイン カテゴリがあります。

• モニタリング レポート ― 選択されたサービスについて、さまざまな粒度（グローバル、パッ
ケージ、サブスクライバ）でネットワーク リソースの使用状況を示します。

• トラフィック ディスカバリ レポート ― ネットワーク アクティビティに関する統計情報を表示
し、ネットワークを通過するトラフィックの特性を識別できるようにします。

レポート インスタンスのプロパティ
複数のテンプレート グループに属するレポート テンプレートに表示されるプロパティについて、
次の表で説明します（1 つのみのテンプレート グループに属するレポート インスタンスのプロパ
ティは、グループの説明とともにリストします）。

表 D-1 レポート インスタンスの共通プロパティ 

プロパティ フィールド タイプ デフォルト 説明

[Items to Focus on] 

次のうちいずれかが大部

分のレポート テンプレー
トに組み込まれます。

　 　 　

[Services to view] 多重選択 (not set) 設定しない場合は、すべての

サービスが選択されます。

[Select services to view] 多重選択 (not set) 設定しない場合は、すべての

サービスが選択されます。

[Focus on the service] 単一選択 (not set) 設定しない場合は、すべての

サービスが選択されます。
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次のうちいずれかが多く

のレポート テンプレー
トに組み込まれます。

　 　 　

[Packages to View] 多重選択 (not set) 設定しない場合は、すべての

パッケージが選択されます。

パッケージ 単一選択

(not set)

必須プロパティ

[Name of subscriber to 
focus on]

フリー テキスト (not set) サブスクライバ テンプレート
グループのレポート インスタ
ンスの必須プロパティ

IP アドレス（10 進フォーマッ
ト）またはサブスクライバ名

[Time Frames to focus] 多重選択 (not set) 設定しない場合は、4 つすべて
の時間枠が選択されます。

時間境界 ― 表のあとの
注を参照

　 　 　

[Starting after date] 日時 (not set) 　

[Ending before date] 日時 (not set) 設定しない場合は、レポートが

現在の時間に拘束されます。

[From the last number of 
hours]

フリー テキスト 24 [Starting After Date] プロパティ
と [Ending Before Date] プロパ
ティを両方とも設定した場合、

表 D-2 は無視されます。

[From the last number of 
Days]

フリー テキスト 7 　

[Specific Time] 日時

(not set)

必須プロパティ

その他 3 つの時間境界プロパ
ティの代わりに、3 つのレポー
ト インスタンス タイプに表示
されます。

選択した時間は、最も近い日付

および時刻に丸められます。

[Traffic Parameters] 

[Link to Focus] 多重選択 (not set) 注目する使用可能リンクのリ

スト

次のうちいずれかが多く

のレポート テンプレー
トに組み込まれます。

　 　 　

[Traffic Direction] 単一選択 レポート テンプ
レートによる

レポート テンプレートによる

• 方向のみ

• 方向およびメトリック

表 D-1 レポート インスタンスの共通プロパティ （続き）

プロパティ フィールド タイプ デフォルト 説明
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• すべてのレポート インスタンスに、[SCE IP to view ] プロパティが含まれます。これによって、
特定の SCE プラットフォームへのフィルタリングが可能になります。このプロパティは必須で
あり、永続的です。永続的とは、値が変更されるまで、現在の値がその後のすべてのレポート
で使用されるということです。

• 時間境界プロパティは、Top Subscribers、Top Talkers、および Relative Consumption of Top 
Subscribers を除くすべてのレポート インスタンスで発生します。これらのプロパティは、次
のとおりです。

• [Starting After Date]

• [Ending Before Date]

• [From the Last Number of Hours/Days]

プロパティ [From the last number of hours/days] は、すべてのレポート インスタンスでデフォルト
値に設定されます。3 つすべての時間境界プロパティを設定した場合、[From the last number of
hours/days ] プロパティは無視されます。プロパティ [Ending before date] を設定しない場合、レポー
トは現在の時間に拘束されます。

[Metric to order] 単一選択 レポート テンプ
レートによる

レポート テンプレートとメト
リックによる

• メトリックのみ

• メトリックおよび方向

[Data Show] 

[Pick BW Over] 単一選択 1 時間

[SCE IP to view] 単一選択 インストール時： 

(not set)

その後：最後に割

り当てられた値

必須プロパティ

特定の Service Control Engine
（SCE）プラットフォームの IP 
アドレス

[Units of results] 単一選択 レポート テンプ
レートによる

　

[Limit number of results] フリー テキスト 10 　

[Average Data by Hour] ブール値 TRUE このオプションを選択した場

合は、レポートの各時間につい

て単一の平均値が計算されま

す。このオプションは、24 時間
以上にわたるレポートを生成

する場合に推奨します。

[Show other Consumption] ブール値 FALSE 　

[Aggregation Period] 単一選択 Hourly 　

[Subscriber Id] フリー テキスト (not set) サブスクライバのグループを

表すパターン

表 D-1 レポート インスタンスの共通プロパティ （続き）

プロパティ フィールド タイプ デフォルト 説明
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モニタリング レポートに関する情報
モニタリング レポートは、ネットワーク リソースの配布および消費に関する情報を提供します。こ
の情報は、ネットワークの使用状況をさまざまな粒度（リンク全体、特定のパッケージ使用カウン

タ内のすべてのサブスクライバが生成するトラフィック、特定のサブスクライバが生成するトラ

フィックなど）で把握する上で役立ちます。これらのレポートは、ネットワーク パターンの変更に
従って Service Control ソリューションの設定を調整する場合に重要です。

モニタリング レポートは、Link Usage、Package Usage、および Real-Time Subscriber Usage Raw Data
Record（RDR）から作成されます。これらの（SCE プラットフォームによって作成される）RDR
は、定期的な（さまざまな粒度の）使用情報を提供します。この情報は選択されたレポート テンプ
レートに従って処理され、最終的なレポートになります。

モニタリング レポートは通常、一連のサービス使用カウンタについて、特定のメトリックを選択さ
れた粒度で示します。たとえば、リンク粒度で示された P2P およびブラウジング サービス使用カ
ウンタの帯域幅や、Gold パッケージ使用カウンタ内のサブスクライバについて示されたストリーミ
ング サービス使用カウンタのボリュームなどです。

SCA Reporter によってレポートするサービス使用カウンタを選択します。選択できるサービス使用
カウンタは、レポートの生成元になる SCE プラットフォームのサービス コンフィギュレーション
で定義されたカウンタです。

• 粒度（p.D-5）

• メトリック（p.D-6）

粒度 

レポート インスタンスの粒度は、作成されたレポートがどのトラフィックを対象とするかを制御し
ます。3 つの粒度がサポートされています。

• グローバル ― レポートされている SCE プラットフォームによって処理されたすべてのトラ
フィックを表示します。グローバル粒度は、ネットワーク リソースのグローバル配信（直前の
24 時間の合計 P2P 帯域幅など）を表示する場合に使用します。

• パッケージ ― 特定のパッケージ使用カウンタ内のサブスクライバにマッピングされたトラ
フィックについてレポートします。パッケージ粒度は、特定のパッケージ使用カウンタに割り

当てられたサブスクライバによるネットワーク リソースの使用方法をモニタする場合に使用
します（たとえば、Gold パッケージ使用カウンタに割り当てられたすべてのサブスクライバに
対する、直前の 10 日間におけるストリーミング トラフィックの合計ボリュームなどです）。シ
ステムでさまざまなパッケージを定義する方法については、『Cisco Service Control Application for
Broadband User Guide』の「Using the Service Configuration Editor: Traffic Control」の章を参照し
てください。

パッケージ使用カウンタ レポートを生成するには、（いずれかのサブスクライバ モードで）サ
ブスクライバを定義して、特定のパッケージに割り当てる必要があります。サブスクライバの
管理方法については、『Cisco Service Control Application for Broadband User Guide』の「Using the
Subscriber Manager GUI Tool」の章を参照してください。

• サブスクライバ ― Service Control ソリューションで定義された単一サブスクライバのアクティ
ビティを表示します。サブスクライバ粒度は、特定のサブスクライバによるネットワーク リ
ソースの使用方法を表示する場合に使用します（直前の 12 時間の 1 時間ごとに、特定のサブ
スクライバが生成した P2P セッション数など）。サブスクライバ レポートはリアルタイム レ
ポートのフラグが設定されたサブスクライバに対して使用できます（リアルタイム サブスクラ
イバ レポートの管理については、『Cisco Service Control Application for Broadband User Guide』の
「Using the Service Configuration Editor: Traffic Accounting and Reporting」の章を参照）。

各レポート テンプレートは、特定の粒度でレポートを生成します。レポートの各タイプには、対応
するレポート テンプレート グループからアクセスできます。
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• グローバル レポート テンプレートには、Global Monitoring テンプレート グループ（p.D-7）か
らアクセスできます。

• パッケージ レポート テンプレートには、Package Monitoring テンプレート グループ（p.D-8）か
らアクセスできます。

• サブスクライバ レポート テンプレートには、Subscriber Monitoring テンプレート グループ
（p.D-10）からアクセスできます。

メトリック

メトリックは、レポート対象の統計情報です。使用できるメトリックは、次のとおりです。

• 帯域幅 ― 選択されたサービスによって消費される合計帯域幅です。デフォルトでは、帯域幅
レポートは積み重ね面グラフとして表示されます。このグラフでは、各エリアが、特定のサー

ビスによって使用される帯域幅を示します。

帯域幅レポートを生成するときは、アップストリーム、ダウンストリーム、またはその両方の
方向を選択できます。

帯域幅の時間平均を表示することもできます。これは、多数の時間にわたるレポートを作成す
るときに推奨されます。そうした場合は通常、時間あたり 1 つのデータ ポイントがあれば十分
です。これによって表示データ数が削減され、パフォーマンスとデータの見やすさが向上しま
す。

• ボリューム ― 選択されたサービス使用カウンタの特定期間における合計ボリューム（キロバ
イトまたはメガバイト単位）です。長期間にわたって平均化されたボリュームを表示する帯域

幅メトリックと対照的に、ボリューム レポートは、特定の期間でグループ化された合計消費ボ
リュームを表示します。デフォルトでは、ボリューム レポートは積み上げ棒グラフとして表示
されます（それぞれの棒 /系列は特定のサービス使用カウンタのボリュームを示します）。

ボリューム レポートは、特定の期間（時間または日）またはレポートの期間全体について累積
使用量を示します。たとえば、Global Hourly Usage Volume レポートは、選択された時間枠の各
時間内に各サービス使用カウンタによって消費された合計ボリュームを示す棒グラフを表示
し、Global Aggregated Usage Volume per Service レポートは、レポートの時間枠全体について、
各サービス使用カウンタのすべてのボリュームを示します。

• セッション ― セッションの数です。セッションは単一のネットワーク トランザクションです
（RTSP ストリームや P2P ファイル ダウンロードなど）。デフォルトでは、セッション レポート
は積み上げ棒グラフとして表示されます（それぞれの棒 / 系列は特定のサービス使用カウンタ
のセッションの合計数を示します）。

ボリューム レポートと同様に、セッション レポートを特定の期間（時間または日）にグルー
プ化して、特定のサービス使用カウンタが特定の時間または日に消費するセッションの合計数
を示すことができます。

トラフィック ディスカバリ レポートに関する情報
トラフィック ディスカバリ レポートは、ネットワーク アクティビティを分析するための未加工の
統計情報を提供します。このレポートは、IP ネットワークの一般的なアクティビティに関する情報
を取得する場合に役立ち、システムのサービス コンフィギュレーションを定義する場合に重要にな
ります。

トラフィック ディスカバリ レポートは、トランザクション RDR 内の情報に基づいています。

トラフィック ディスカバリ レポートは、選択した基準でグループ化され、選択した順序パラメー
タで並べ替えられた、ヒストグラムおよび分布図を生成します。たとえば、上位プロトコル レポー
トは Total Volume でソートされ、上位 Web ホスト レポートは Hit-Count でソートされます。

• 基準（p.D-7）

• 順序プロパティ（p.D-7）
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基準

各レポート テンプレートは、レイヤ 3 ～ 7 に基づく、次のような特定の基準を主に使用しています。

• 上位サーバ IP アドレス

• 上位サーバ ポート番号

• 上位 HTTP Web ホスト

• 上位 NNTP ニュースグループ

順序プロパティ

プロパティを順序付けるメトリックは、レポートのソート キーとなる値を示します。可能な値は次
のとおりです。

• アップストリーム ボリューム

• ダウンストリーム ボリューム

• 両方向ボリューム ― アップストリームおよびダウンストリーム ボリューム合計

• ヒットカウント ― トランザクションの数

各レポートの結果を特定の個数に制限できます。これにより、（選択した値に応じて）アクティビ

ティの上位エリアに焦点を合わせることができます。

Global Monitoring テンプレート グループ
レポート テンプレートの Global Monitoring グループでは、消費されたトラフィック帯域幅またはボ
リュームに関する統計情報を表示できます。帯域幅 /ボリューム消費は、リンク全体に対して、サー
ビス単位で表示できます。

Global Monitoring グループには、次のレポート テンプレートがあります。

• Global Bandwidth per Service ― サブスクライバやパッケージに関係なくすべてのトラフィック
に対する、システム内で定義されたサービス間の帯域幅分布を示します。

• Global Aggregated Usage Volume per Service ― サブスクライバやパッケージに関係なくすべての
トラフィックに対して、サービス使用カウンタごとに合計トラフィック ボリューム（アップス
トリームおよびダウンストリーム）を示します。

• Global Hourly Usage Volume per Service ― システムで定義されたさまざまなサービス使用カウン
タ間におけるボリューム分布を 1 時間ごとに表示します。

• Global Hourly Aggregated Minutes per Service ― システムで定義された各サービス使用カウンタ
で使用された合計時間（分単位）を 1 時間ごとに表示します。

• Global Hourly Usage Sessions per Service ― システムで定義されたさまざまなサービス使用カウ
ンタ間におけるセッション分布を 1 時間ごとに表示します。

• Global Concurrent Session per Service ― システムで定義されたさまざまなサービス使用カウンタ
間における同時セッションの分布を表示します。

• Global Daily Usage Sessions per Service ― システムで定義されたさまざまなサービス使用カウン
タ間におけるセッション分布を 1 日ごとに表示します。

• Global Daily Usage Volume per Service ― システムで定義されたさまざまなサービス使用カウン
タ間におけるボリューム分布を 1 日ごとに表示します。

• Daily Peak BW for All Packages
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Package Monitoring テンプレート グループ
レポート テンプレートの Package Monitoring グループでは、パッケージが使用するトラフィックの
帯域幅またはボリュームの統計情報を表示できます。このレポートは、パッケージが使用する合計

ボリュームに対して、サービス使用カウンタごとに表示されます。ボリューム消費は、パッケージ

のサービスごとに表示できます。

Package Monitoring グループには、次のレポート テンプレートがあります。

• Package Bandwidth per Service ― 特定のパッケージに属するすべてのサブスクライバに対する、
システム内で定義されたサービス使用カウンタ間の帯域幅分布を示します。

• Package Aggregated Usage Volume per Service ― 特定パッケージのサブスクライバのサービス使
用カウンタごとに合計トラフィック ボリューム（アップストリームおよびダウンストリーム）
を示します。

• Package Hourly Usage Volume per Service ― 特定のパッケージ使用カウンタのサブスクライバの
トラフィックに対する、システム内で定義されたサービス使用カウンタ間のボリューム分布

を、時間でグループ化して示します。

• Package Hourly Aggregated Minutes per Service ― システムで定義された特定のパッケージ使用カ
ウンタの各サービス使用カウンタで使用された合計時間（分単位）を 1 時間ごとに表示します。

• Package Hourly Usage Sessions per Service ― 特定のパッケージのサブスクライバのトラフィック
に対する、システム内で定義されたサービス使用カウンタ間のセッション分布を、時間でグ

ループ化して示します。

• Package Concurrent Session per Service ― システムで定義された特定のパッケージ使用カウンタ
のさまざまなサービス使用カウンタ間における同時セッションの分布を表示します。

• Package Daily Usage Sessions per Service ― 特定のパッケージ使用カウンタのサブスクライバの
トラフィックに対する、システム内で定義されたサービス使用カウンタ間のセッション分布

を、日でグループ化して示します。

• Package Daily Usage Volume per Service ― 特定のパッケージ使用カウンタのサブスクライバのト
ラフィックに対する、システム内で定義されたサービス使用カウンタ間のボリューム分布を、

日でグループ化して示します。

• Daily Peak BW for Each Package
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Virtual Links Monitoring テンプレート グループ
レポート テンプレートの Virtual Links Monitoring グループでは、仮想リンクが使用するトラフィッ
クの帯域幅またはボリュームの統計情報を表示できます。このレポートは、仮想リンクが使用する

合計ボリュームに対して、サービス使用カウンタごとに表示されます。ボリューム消費は、仮想リ

ンクのサービスごとに表示できます。

これらのレポートは、非対称ルーティング分類モードで動作する SCE プラットフォームから収集さ
れたデータを使用して作成することはできません。

Virtual Links Monitoring グループには、次のレポート テンプレートがあります。

• VLink Bandwidth per Service ― システムで定義されたさまざまなサービス使用カウンタ間にお
ける、すべてのサブスクライバの帯域幅分布を表示します。

• VLink Aggregated Usage Volume per Service ― サービス使用カウンタごとに合計トラフィック ボ
リューム（アップストリームおよびダウンストリーム）を示します。

• VLink Hourly Usage Volume per Service ― システムで定義されたさまざまなサービス使用カウン
タ間におけるボリューム分布を 1 時間ごとに表示します。

• VLink Daily Usage Volume per Service ― システムで定義されたさまざまなサービス使用カウン
タ間におけるボリューム分布を 1 日ごとに表示します。

• Daily Peak BW for all VLinks

表 D-2 Virtual Links Monitoring グループ テンプレートのみのプロパティ

プロパティ フィールド タイプ デフォルト 説明

[Items to Focus on] 

[Select VLink ID] フリー テキスト (not set)

[Select VLink direction] 単一選択 (not set)

[Select VLink names] 多重選択 (not set)
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Subscriber Monitoring テンプレート グループ
レポート テンプレートの Subscriber Monitoring グループでは、サブスクライバが使用するトラ
フィックの帯域幅またはボリュームに関する統計情報を表示できます。このレポートは、サブスク

ライバが消費する合計ボリュームに対して、サービス使用カウンタごとに表示されます。Top
Subscribers レポートは、トラフィック ボリュームを最も消費するサブスクライバを識別します。サ
ブスクライバの帯域幅およびボリュームに関するレポートは、リアルタイム モニタリングが設定さ
れたサブスクライバに対して作成できます。リアルタイム サブスクライバの設定方法については、
『Cisco Service Control Application for Broadband User Guide 』の「Additional Management Tools and

Interfaces」の章にある「Selecting Subscribers for Real-Time Usage Monitoring」を参照してください。

Subscriber Monitoring グループには、次のレポート テンプレートがあります。

• Top Subscribers ― 特定日時における上位サブスクライバのボリューム消費のリストを表示しま
す。

• Subscriber Bandwidth per Service ― システムで定義されたさまざまなサービス使用カウンタ間に
おける、特定サブスクライバの帯域幅分布を表示します。

• Subscriber Aggregated Usage Volume per Service ― 特定サブスクライバで最も数値が高いサービ
ス使用カウンタを表示します。

• Subscriber Hourly Usage Volume per Service ― システムで定義されたさまざまなサービス使用カ
ウンタ間における、特定サブスクライバの 1 時間ごとのボリューム分布を表示します。

• Subscriber Hourly Aggregated Minutes per Service ― システムで定義された特定のパッケージ使用
カウンタの各サービス使用カウンタで使用された合計時間（分単位）を 1 時間ごとに表示しま
す。

• Subscriber Hourly Usage Sessions per Service ― システムで定義されたさまざまなサービス使用カ
ウンタ間における、特定サブスクライバの 1 時間ごとのセッション分布を表示します。

• Subscriber Daily Usage Sessions per Service ― システムで定義されたさまざまなサービス使用カ
ウンタ間における、特定サブスクライバの 1 日ごとのセッション分布を表示します。

• Subscriber Daily Usage Volume per Service ― システムで定義されたさまざまなサービス使用カウ
ンタ間における、特定サブスクライバの 1 日ごとのボリューム分布を表示します。

• Daily Peak BW for Specific Subscriber
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Traffic Discovery - Statistics テンプレート グループ
レポート テンプレートの Traffic Discovery - Statistics グループでは、システム トラフィックの送信
元と宛先 IP アドレスおよびポートから編集された統計情報を表示できます。

これらのレポートは、非対称ルーティング分類モードで動作する SCE プラットフォームから収集さ
れたデータを使用して作成することはできません。

（注） このグループのレポートはサブスクライバ単位ではなく、一般的なポートおよび IP アドレス情報
を示します。

Traffic Discovery - Statistics グループには、次のレポート テンプレートが含まれます。

• Top Servers ― 特定サービスで最も使用されているサーバを表示します。

（注） サーバとは、フロー発信側の反対側の IP アドレスのことです。サブスクライバ側またはネットワー
ク側に配置されていることがあります。

• Top Client ― 特定サービスで最も使用されているクライアント IP を表示します。

（注） クライアントとは、フロー発信側の IP アドレスのことです。サブスクライバ側またはネットワー
ク側に配置されていることがあります。

• Top Server Ports ― 特定サービスに最も使用されているサーバ ポートを表示します。

• Top Service Ports ― 特定の単一サービスまたは複数のサービスで最も使用されているサーバ
ポートを表示します。

• Top Protocols ― 特定サービスで最も使用されているプロトコルを表示します。

• Top IP Protocols ― 特定サービスに最も使用されている IP プロトコルを表示します。

• Top Server IP to Server Port ― 特定サービス用サーバ ポートで最も使用されているサーバ IP を
表示します。

• Top Client IP to Server Port ― 特定サービス用サーバ ポートで最も使用されているクライアント
IP を表示します。

• Top Client IP to Server IP ― 特定サービス用サーバ IP で最も使用されているクライアント IP を
表示します。

• Top Client IP to Server IP and Server Port ― 特定サービスに最も使用されているサーバ IP および
サーバ ポートを表示します。

表 D-3 Traffic Discovery - Statistics グループ テンプレートのみのプロパティ

プロパティ フィールド タイプ デフォルト 説明

[Traffic Parameters] 　 　 　

[Transport Protocol] 単一選択 TCP 　
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Demographic Data and Service Popularity レポート テンプレート グ
ループ

レポート テンプレートの Demographic Data and Service Popularity グループでは、人口統計データの
統計情報を表示できます。

Demographic Data and Service Popularity グループには、次のレポート テンプレートが含まれます。

• Global Active Subscriber per Service ― サブスクライバやパッケージに関係なくすべてのトラ
フィックに対する、システム内で定義されたサービス間のサブスクライバ分布を示します。

• Package Active Subscriber per Service ― システムで定義されたさまざまなサービス間における、
特定サブスクライバ パッケージの帯域幅分布を表示します。

• Service Popularity among Subscribers ― システムで定義されている特定サービスを使用している
サブスクライバのパーセンテージを表示します。

• Service Popularity among Subscribers of a Specific Package ― システムで定義されている特定パッ
ケージの特定サービスを使用しているサブスクライバのパーセンテージを表示します。

• Relative Consumption of Top Subscribers ― 「その他のサブスクライバ」と比較して、特定数のサ
ブスクライバの相対消費を表示します。

• Service Popularity among Subscribers (Average) ― 特定サービスを使用しているサブスクライバの
合計数を、その他すべてのサービスを使用しているサブスクライバ数と比較して表示します。

• Service Popularity among Subscribers of a Specific Package (Average) ― 特定サービスを使用してい
るサブスクライバの合計数を、特定パッケージのその他すべてのサービスを使用しているサブ

スクライバ数と比較して表示します。
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Web and Streaming レポート テンプレート グループ
レポート テンプレートの Web and Streaming グループでは、事前に定義されたさまざまなシステム
サービス（ブラウジング、ストリーミング、およびダウンロードなど）およびユーザ定義サービス

に対する一般的なサーバまたはホストを示す統計情報を編集できます。

これらのレポートは、非対称ルーティング分類モードで動作する SCE プラットフォームから収集さ
れたデータを使用して作成することはできません。

Web and Streaming グループには、次のレポート テンプレートが含まれます。

• Top Web Hosts ― 最も使用されている Web サーバを表示します。

• Top Rtsp Hosts ― 最も使用されている Real-Time Streaming Protocol（RTSP）サーバを表示します。

• Top FTP Servers ― 最も使用されている FTP ファイル ホストを表示します。

• Top MMS Servers ― 最も使用されている MMS ホストを表示します。

• Top Service Servers ― 特定の単一サービスまたは複数のサービスで最も使用されているサーバ
を表示します。

• Service Distribution by Subscriber Packages ― 要求側サブスクライバのパッケージごとに、最も使
用されている Web サーバを表示します。

• Rtsp Host Distribution by Subscriber Packages ― 要求側サブスクライバのパッケージごとに、最も
使用されている Rtsp サーバを表示します。

• FTP Server Distribution by Subscriber Packages ― 要求側サブスクライバのパッケージごとに、最
も使用されている FTP ファイル サーバを表示します。

• MMS Server Distribution by Subscriber Packages ― 要求側サブスクライバのパッケージごとに、最
も使用されている Microsoft Manager Server サーバを表示します。

• Service Distribution by Subscriber Packages ― サブスクライバ パッケージに従って、サービス使
用量の分布を表示します。

表 D-4 Web and Streaming グループ テンプレートのみのプロパティ

プロパティ フィールド タイプ デフォルト 説明

[Items to Focus on] 　 　 　

[Where host is contained] フリー テキスト (not set) 特定パターンを含むホスト

をフィルタ処理します。
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Mail and News レポート テンプレート グループ
レポート テンプレートの Mail and News グループでは、メールおよびニュース トラフィックの統計
情報を表示できます。

これらのレポートは、非対称ルーティング分類モードで動作する SCE プラットフォームから収集さ
れたデータを使用して作成することはできません。

Mail and News グループには、次のレポート テンプレートが含まれます。

• Top SMTP Servers ― 最も使用されている SMTP ホストを表示します。

• Top POP3 Servers ― 最も使用されている POP3 ホストを表示します。

• Top NNTP Servers ― 最も使用されている NNTP ホストを表示します。

• TOP E-mail Sender ― 上位電子メール送信者を表示します。

• TOP E-mail Recipients ― 上位電子メール受信者を表示します。

• Top NNTP Consumers ― 上位 NNTP コンシューマを表示します。

• Top Newsgroups ― 最も使用されているニュースグループを表示します。

• SMTP Server Distribution by Subscriber Packages ― 要求側サブスクライバのパッケージごとに、
最も使用されている SMTP サーバを表示します。

• POP3 Server Distribution by Subscriber Packages ― 要求側サブスクライバのパッケージごとに、最
も使用されている POP3 サーバを表示します。

• NNTP Server Distribution by Subscriber Packages ― 要求側サブスクライバのパッケージごとに、
最も使用されている NNTP サーバを表示します。

• Top Subscriber to Newsgroup ― 特定サービスのニュースグループの上位サブスクライバを表示
します。

• Top E-mail Account Owners ― 上位電子メール アカウント オーナーを表示します。

P2P レポート テンプレート グループ
レポート テンプレートの P2P グループでは、P2P トラフィックの統計情報を表示できます。

これらのレポートは、非対称ルーティング分類モードで動作する SCE プラットフォームから収集さ
れたデータを使用して作成することはできません。

P2P グループには次のレポート テンプレートがあります。

• Top P2P Protocols ― 特定サービスで最も使用されている P2P プロトコルを表示します。

• Top P2P Consumers ― 上位 P2P サブスクライバ ボリューム消費のリストを表示します。

• Top P2P Downloaders ― 上位 P2P ダウンロード コンシューマを表示します。

• Top P2P Uploaders ― 最も使用されている P2P アップロード コンシューマを表示します。
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VoIP レポート テンプレート グループ
レポート テンプレートの VoIP グループでは、VoIP トラフィックの統計情報を表示できます。

これらのレポートは、非対称ルーティング分類モードで動作する SCE プラットフォームから収集さ
れたデータを使用して作成することはできません。

VoIP グループには次のレポート テンプレートがあります。

• Global Bandwidth per VoIP Service ― サブスクライバやパッケージに関係なくすべてのトラ
フィックに対する、システム内で定義された VoIP サービス間の帯域幅分布を示します。

• Global Concurrent Calls per VoIP Service ― システムで定義されたさまざまな VoIP サービス使用
カウンタ間における同時セッション分布を 1 日ごとに表示します。

• Global Hourly Call Minutes per VoIP Service ― システムで定義されたさまざまな VoIP サービス
使用カウンタ間におけるコール時間（分単位）の分布を 1 日ごとに表示します。

• Package Bandwidth per VoIP Service ― 特定パッケージのサブスクライバのトラフィックに対す
る、システム内で定義された VoIP サービス間の帯域幅分布を示します。

• Packet Concurrent Calls per VoIP Service ― システムで定義されたさまざまな VoIP サービス使用
カウンタ間における同時セッション分布を 1 日ごとに表示します。

• Package Hourly Call Minutes per VoIP Service ― システムで定義されたさまざまな VoIP サービス
使用カウンタ間におけるコール時間（分単位）の分布を 1 日ごとに表示します。

• Subscriber Bandwidth per VoIP Service ― 特定パッケージのサブスクライバのトラフィックに対
する、システム内で定義された VoIP サービス間の帯域幅分布を示します。

• Subscriber Hourly Call Minutes per VoIP Service ― システムで定義されたさまざまな VoIP サービ
ス使用カウンタ間におけるコール時間（分単位）の分布を 1 日ごとに表示します。

• Top SIP Domains ― 最も使用されている SIP ドメインを表示します。

• Top Talkers ― 特定のまたはすべての VoIP サービスに対する、特定の時間 /日におけるトーカー
のボリューム /セッション /分数の上位消費量を一覧表示します。

• Global VoIP Packets Loss

• Global VoIP Jitter

• Global Hourly Average VoIP Packets Loss

• Global Hourly Average VoIP Jitter

• Global VoIP MOS

• Global Hourly Average VoIP MOS

• Global VoIP MOS Distribution

• Global VoIP Codec Distribution

表 D-5 VoIP グループ テンプレートのみのプロパティ

プロパティ フィールド タイプ デフォルト 説明

[Data Show] 　 　 　

[Codec to filter] 多重選択 (not set) 　
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Malicious Traffic テンプレート グループ
レポート テンプレートの Malicious Traffic グループでは、システムで発生した悪質イベントの統計
情報を表示できます。

Malicious Traffic グループには次のレポート テンプレートがあります。

• Global Scan or Attack Rate ― ホストから発信されたスキャンおよび攻撃（一般的にワームまた
はゾンビのため）のレート（1 秒あたりのセッション数）を表示します。

• Global Dos Rate ― 標的ホストにおける DoS 攻撃のレート（1 秒あたりのセッション数）を表示
します。

• Top Scanning or Attacking Hosts ― DoS 攻撃をしているものとして識別される上位ホストを表示
します。

• Top Dos Attacked Hosts ― DoS 攻撃を受けている上位ホストを表示します。

• Infected Subscribers ― システムのさまざまな IP プロトコル間における、感染サブスクライバの
分布を時間の経過とともに表示します。

• DoS Attacked Subscribers ― システムで定義されているさまざまな IP プロトコル間における、
DoS 攻撃を受けたサブスクライバの分布を時間の経過とともに表示します。

• Top Dos Attacked Subscribers ― DoS 攻撃を受けている上位サブスクライバを表示します。

• Top Scanning or Attacking subscribers ― DoS 攻撃をしているものとして識別される上位サブスク
ライバを表示します。

• Top Scanned or Attacked Ports ― スキャンされたか攻撃された上位ポートを表示します。

表 D-6 Malicious Traffic グループ テンプレートのみのプロパティ

プロパティ フィールド タイプ デフォルト 説明

[Traffic Parameters] 　 　 　

[IP protocol] 単一選択 (not set) 　

[Filter to port] フリー テキスト (not set) 　

[Detected IP side] 単一選択 (not set) 　
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